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1 Introduction 
The Web Client software enables you to capture checks and create electronic deposits that are securely 
transmitted to the bank for processing.  

This guide includes the following information: 

 Getting Started  

 Making Deposits  
 Reviewing Deposits 

• Reporting  
 User Administration 
 Internet Explorer Security Settings  

For information about the reporting features of Web Client, see the Reporting User Guide. 

This section includes the following information: 

 Web Client Overview  

 System Requirements  

 Support  

Web Client Overview 
Web Client works via the web, making installation of software unnecessary and allowing you to access the 
application from any PC that meets the minimum requirements. 

The Web Client application includes the following features. 

 Capture and Modify Item Information: The application allows you to capture images, amounts, and 
MICR line information. You can also modify the MICR information and custom fields before 
submitting deposits to your service organization. 

 Review Reports and Status: The application allows you to generate deposit reports and view the 
status of deposit transmissions to your service organization. 

System Requirements 
To run Web Client, you must have a computer that has at least the following configuration: 

Minimum Requirements  

Workstation • Intel or AMD > 1 GHz CPU (Dual and Quad core processors 
supported) 

• 1 GB RAM 
• 4 GB RAM recommended 
• Monitor with 1024 x 768 resolution 
• 20 GB HDD, with at least 500 MB of free disk space 
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Minimum Requirements  

Operating System One of the following: 
• Microsoft Windows 7 Professional or Ultimate 
• Microsoft Windows 8.1 
• Microsoft Windows 10 
• macOS High Sierra (10.13) 
• macOS Mojave (10.14) 
• macOS Catalina (10.15) 

All 32-bit version operating systems are supported while most 64-bit 
versions are supported, depending on the scanner. 

Software • Internet Explorer 11, 32- and 64-bit versions only (for Windows only); 
see Internet Explorer Security Settings for security recommendations. 

• Mozilla Firefox, 32- and 64-bit (EPSON scanners are not supported 
with Mozilla Firefox) 

• Google Chrome 
• Safari (for Mac only) 
• Microsoft Edge on Chromium 

Network Connectivity • DSL/Broadband 256 kbps or greater 
• If a firewall is being used, the appropriate TCP/IP ports must be open. 

Contact your Service Representative or network administrator for this 
information. 

User Permissions If the user is not an administrator, they will need an administrator to help 
install any necessary drivers on their computer. 
User must be given the necessary NetCapture privileges to access Web 
Client. 

Check Scanner 
Must use one of these 
supported check scanners. 
Note: A scanner is only 
required for users that will 
be performing scanning 
functions. 

Digital Check (DCC) TS230, TS240, CheXpress CX30. Additional 
requirements: 
• USB cable 
• USB 2.0 compatible port 
• Windows 7, Windows 8.1, Windows 10 
• macOS High Sierra, macOS Mojave 
• 32 or 64-bit 

Panini Vision X 1F, 50, 75, 100, I:Deal, Vision 1. Additional requirements: 
• USB cable 
• USB 2.0 compatible port 
• Windows 7, Windows 8.1, Windows 10 
• macOS Sierra, macOS High Sierra 
• 32 or 64-bit 

Epson, all TM-S1000 models 
• USB cable 
• USB 2.0 compatible port 
• Windows 7, Windows 8.1, Windows 10 
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Support 
You can get support through the Web Client online help or from your Service Representative. 

Online Help 
From the Help menu, select Help > User Guide to get online help from any Web Client window. 

When the online help is launched you may need to choose the option to allow blocked content in order to view 
the help contents. 

 Click the yellow bar at the top of the window and choose Allow Blocked Content. 

A security warning appears. 

 Click Yes to continue. 

If you are using Internet Explorer and want to prevent this message from appearing each time you launch the 
online help, you can change a security setting in Internet Explorer. However, changing this setting is not 
recommended because it may compromise your computer’s security. 

1. Open Internet Explorer. 

 Select Tools > Internet Options. 

 Click the Advanced tab. 

 Scroll down to the Security section. 

 Select the check box “Allow active content to run in filed on My Computer”. 

 Click Apply. 

Technical Support 
Contact your Service Representative with questions about the following: 

 User names 
 Passwords 
 Check Scanners (if you are using check scanning functions) 
 Browser Settings 

For other questions or problems with the Web Client application, see User Administration 

The Admin tab allows an organization to administer their users within their home organization. An admin can 
create new users, assign user roles, reset user passwords, and clone existing users. Depending on the 
privileges your service provider has configured for your organization, the Admin tab may not be accessible. 

Note: The Admin tab does not support administration of users across multiple orgs. 

This chapter contains the following information: 

• Searching for a User 
• Creating a User 

 

• Editing a User 
• Cloning a User  
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Searching for a User 
You can search for a user by entering the user name, email address, or user status in the Search Users text 
box and the grid will automatically filter a list of users as you type.  

 

You will only see users that you have access to from your home organization. Users from other organizations 
will not be displayed on Admin tab even though you might have access to them.  

 

The list of users contains the following information: 

Column Description 

User Name The user name of the user. 

First Name The first name of the user. 

Last Name The last name of the user. 

Status The status of the user. The status can be Active or Inactive. 

Email for Mobile 
Alerts 

The email address of the user for email notifications about deposits submitted from 
the Mobile application. 

Deposit Review 
Limit 

Deposit limit threshold for the user that will require a secondary approval (Dual 
Control) before being submitted to the financial institution. See Reviewing Deposits 
for more information. 
Note: This field will only be displayed if the Dual Control rule is active. 

Clone User Allows you to create a new user by cloning an existing user. See Cloning a User for 
more information. 

Note: To display or hide any fields in the grid, left mouse-click on the right corner of a column header, select 
Columns, and select columns for display in the drop-down list. Columns in the grid can be rearranged and 
resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort Ascending or 
Sort Descending. 

Creating a User 
To create a user, do the following: 

 On the Admin screen, click on the New button. 
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 The Create User screen appears with the Profile tab selected.  

 
Enter the following information into the fields on the Profile tab: 

Field Description 

User Name The user name that will be used to login to Web Client. 
Note: Once a user’s user name is created and saved, it cannot be changed. 

First Name The first name of the user. 

Last Name The last name of the user. 

Password The default password for the user. 
Note: This field is only displayed if applicable for your organization. 

Confirm Password The confirmation of the default password previously entered. 
Note: This field is only displayed if applicable for your organization. 

Email for Mobile 
Alerts 

The email address that will be used for mobile deposit alerts.. 
Note: This field is only displayed if your organization is configured for Mobile 
deposits. 

Deposit Review 
Limit 

The deposit limit threshold for the user that will require a secondary 
approval (Dual Control) before being submitted to the financial institution.  
Note: This field will only be displayed if the Dual Control rule is active. 

Note: Required fields are marked with an asterisk. 

 Click Next to create the user’s profile and advance to the Assign Roles tab.  

 On the Assign Roles tab, select the check box next to the role that you want to assign to the user in 
the Assigned Roles section.  

Note: The list of roles will not exceed the admin’s privileges.  
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 The information displayed in the Account Access column depends on the displayed role. Some roles 

can be assigned at the account level and other roles can only be assigned at the customer level.  

The account access levels are: 

− Customer level: The user will have access to all accounts within their organization. If a new 
account is added to the organization at any time, users will automatically get access to that 
account.  All Accounts will be displayed in the Account Access column for each customer 
level role. 

− Account level: The user will have access to the specific account selected. If a new account is 
added to the organization at any time, user roles need to be updated to access that account.  
All account levels roles will have a drop-down list of available accounts to assign to the user 
role. 

 
 Click Done when you finish assigning roles to the user. 

The roles are now assigned to the new user.  
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Editing a User 
The profile and assigned roles can be updated when editing a user. On the user’s profile, all information 
except for the user name can be edited. Assigned roles and accounts can be added or removed. 

To edit a user, do the following: 

 On the Admin screen, click on the user name in the grid that you want to edit. 

 The Update User screen appears.  

 
You can edit the following fields on the Update User screen: 

Field Description 

First Name The first name of the user. 

Last Name The last name of the user. 

Password The password for the user. 
Note: This field is only displayed if applicable for your organization. 

Confirm Password The password a second time to confirm it is correct. 
Note: This field is only displayed if applicable for your organization. 

Status The status of the user. The status can be one of the following: 
• Active:  The user is able to log in to the application. 
• Inactive:  The user is deactivated and cannot log in to the application. 

You can set any user into Inactive status if needed. 
Note: If a user is locked out of the application due to failed attempts to 
login or due to inactivity, the user status will be displayed as Inactive. 
You can restore the user’s status to Active at any time. 

• Deleted: The user will no longer be displayed in the list of users but will 
still be visible in the reports associated with the deposits made by this 
user.  
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Field Description 

Email for Mobile 
Alerts 

The email address for the user to receive mobile alerts regarding deposits 
made from the Mobile application. 
Note: This field is only displayed if your organization is configured for Mobile 
deposits. 

Deposit Review 
Limit 

The deposit review limit amount for the user.  
Note: This field will only be displayed if the Dual Control rule is active. 

 Click Next to save the changes and advance to the Assign Roles screen.  

Changes to the user’s profile will be saved.  

 On the Assign Roles screen, you can do the following: 

− Delete a role: Uncheck the check box next to the role in the Role column to delete a role. 
− Add a role: Select the check box next to the role in the Role column to add a role. 
− Remove an account from a user’s access: Select the required role in the Role column and 

uncheck the check box next to the account in the Accounts section to remove an account 
from the user’s access. 

− Add a new account to a user’s access: Select the required role in the Role column and select 
the account in the Accounts section that you want to add to the user access.  

 Click Done to save the changes. 

Changes to the user’s assigned roles and accounts will be saved. 

Cloning a User 
A new user can be created by cloning an existing user from the Admin tab.  

To clone a user, do the following: 

 In the Clone User column on the Admin screen, click on the Clone icon  next to the user to be 
cloned. The Cloning User screen appears with the Profile tab selected.  
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Enter the fields on the Profile tab. See Creating a User for more information about the fields on the 
screen. 

Note: If your organization has been configured for Dual Control, the Deposit Review limit field is the 
only field that will be populated with the amount from the cloned user. All other profile information is 
unique to the new user. 

 Click Next to create the user profile and advance to the Assign Roles tab. The Assigned Roles tab will 
be prepopulated with the roles from the cloned user.  

 
Make necessary changes to the displayed roles or save them as is by clicking the Done button. 

Note: Roles are not saved for the new user until you click Done. 

The new user has now been created. 
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Troubleshooting. 
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2 Getting Started 
Before you start making deposits, you should understand the Web Client deposit process, including the 
following information: 

 Logging into Web Client 
 Scanner Setup Process  
 Understanding Checks and MICR Information 
 Using the Check Scanner 
 Deposit Overview 
 Exiting Web Client 

Logging into Web Client 
Web Client is only available during the working hours configured by your service organization. 

Most of the time you will use the Standard Login Process when logging into the system. The first time you log 
in you are required to set up the application and change your password. See First Time Login Process and 
Password Change. 

Note: While using Web Client, do not open another browser window. This could cause errors. 

Web Client allows you to be logged in at only one workstation at a time. If you need to switch workstations, 
you must log out at your current workstation first. 

Standard Login Process 
Depending on how your service organization has configured it, you can log in through Basic or Multi-Factor 
Authentication login. 

Basic Login 

Do the following to log in to the system: 

 Open your browser and navigate to the URL provided by your service organization for accessing the 
application. 

OR 

Click the link your service organization set up to start Web Client. 

The application login screen appears. 

 In the User Name field, enter your user name exactly as it was provided to you by your Service 
Representative. User names are case sensitive. 

Note: If the Remember Me check box is selected when you log in, the User Name field will be 
prepopulated with your user name. 

 In the Password field, enter your password exactly as it was provided to you by your Service 
Representative. Passwords are case sensitive.  

 If you are prompted to change your password, see Password Change. 

 If your service organization has configured it, a license message appears. Read the message and click 
Accept to accept the conditions of the agreement and continue. (If you click Reject, you will not be 
allowed to log in to the application.) 

You are now logged in to Web Client. You can now begin the deposit process. See Making Deposits. 
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Multi-Factor Authentication Login 
 Open your browser and navigate to the URL provided by your service organization for accessing the 

application. 

OR 

Click the link your service organization set up to start Web Client. 

The application login screen appears. 

 In the User Name field, enter your user name exactly as it was provided to you by your Service 
Representative. User names are case sensitive. 

 Click the Submit button. 

Note: If you did not register your computer the first time you logged in, you will need to answer two 
security questions correctly before you can enter your password. 

 In the Password field, enter the password you created. Passwords are case sensitive. 

 Click the Submit button. 

Note: If your computer is not registered, you can register your computer in the Remember this 
computer field on the Register Computer screen. 

You are now logged in to Web Client and can now begin the deposit process. See Making Deposits. 

First Time Login Process 
The first time you log in to Web Client, you will be prompted to perform some setup tasks. After the first login, 
you will usually not be asked to set up any additional software or settings. If your administrator has already 
set up the computer for you, or another person uses the application to submit deposits, these steps may not 
apply to you. See the Standard Login Process. 

Check Your Windows User Account Privileges 

Because the first-time setup may require you to install some pieces of software, you either need to log in to 
the workstation as an administrator or have someone with administrative rights log in for you. You will not be 
able to install the needed components if you are logged in with restricted user rights. After you have 
completed the initial setup, you can log in to the workstation using your normal Windows account. 

If you are not sure whether you have administrative or restricted user rights, you can determine what 
privileges are assigned to your Windows user account by doing the following: 

 Open the Windows Control Panel. For most users, click Start > Control Panel. 

The Control Panel appears. 

 Double-click User Accounts. 

The User Accounts Window appears. 

 Select your User Name and click Properties. 

The Properties dialog box for your User Name appears. The selected Membership should be either 
Standard user or Administrator. 

Note: If your Membership is something other than Standard or Administrator, you will need to have 
your rights changed or have a user with Administrator rights log in to complete the initial setup. 

 Click Cancel to close the Properties dialog box and Cancel to close the User Accounts window. 

Logging In 

Depending on how your service organization has configured it, you can log in through Basic login or Multi-
Factor Authentication login. 
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 Open your browser and navigate to the URL provided by your service organization for accessing the 
application. 

OR 

Click the link your service organization set up to start Web Client. 

Basic First Time Login 
 The Web Client login screen appears. 

 
In the User Name field on the Web Client log in screen, enter your user name exactly as it was 
provided to you by your Service Representative. User names are case sensitive. 

 In the Password field, enter your password exactly as it was provided to you by your Service 
Representative. Passwords are case sensitive.  

 Select the Remember Me check box if you want the application to remember your user name in the 
future.  

Note: The Remember Me check box can be cleared (deselected) when logging in at any time.  

 Click the Submit button. 

Because this is your first time logging in, a screen appears that prompts you for a new password. See 
Password Change. 

Multi-Factor Authentication First Time Login 
 In the User Name field, enter your user name exactly as it was provided to you by your Service 

Representative. User names are case sensitive. 

 
 In the Password field, enter your password exactly as it was provided to you by your Service 

Representative. Passwords are case sensitive. 

Click the Submit button.  

 The Start Enrollment screen appears. 

Click the Enroll button to start enrollment. 
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 Choose three security questions and enter their answers. This provides extra security and verifies your 

identity if there are any problems logging in.  

 
Click the Submit button. 

 If you choose to register your computer, the application will remember it and you will be able to sign 
into the system without answering the security questions you provided. 

To register your computer, select the check box and enter what you want your computer to be 
registered as.  

 
Click the Submit button. 

 In the Old Password field, enter the password your service organization provided to you. 

 
 In the New Password field, enter a new password of your choosing. 
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 In the Confirm New Password field, enter your new password again. 

After you change your password, the Process Checks screen opens.  

Scanner Setup Process  
IMPORTANT! To complete the scanner installation process, you must be logged in as an administrator. If you 
are not logged in as an administrator, you should click Cancel, close the application, and have an 
administrator log in to continue with the setup process. 

 The Begin Installation screen appears. 

Click Next to continue with scanner installation. 

 
 The Select Scanner screen appears. 

Select your scanner model from the drop-down box and click Next. 

Note: The list of scanners available to you may vary depending on what has been configured in the 
system. 

 
If you are using Firefox, you will see the Install Certificate screen instead of the Select Scanner 
screen. Follow the steps below. 

a) Follow the instructions listed on the screen.  
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b) Click Next. 

Once the certificate is installed, the Select Scanner screen appears and you may proceed 
with scanner selection steps at the beginning of step 2. 

 The Launch Installer screen appears. 

Click the Download the Installer link. 

 
Depending on the type of browser you are using, follow the steps in the table below. 
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Operating 
System Browser Steps 

Windows Firefox A dialog box appears asking if you would like to save the file. 

 
Click Save File. 
Go to your downloads by clicking on the arrow in the browser toolbar. 

 
Select your scanner file from the list of downloads. 
A security message appears asking if you would like to run the program. 
To accept the software and allow it to install, click either OK or Run, 
depending on your browser and security settings. 

Google 
Chrome 

At the bottom left of the screen, click on the arrow to the right of the Setup 
Scanner file and click Open. 

 

Internet 
Explorer 

At the bottom of the screen, one or more security messages may appear. 

 
Click Run. 

Microsoft 
Edge 

At the bottom left of the screen, click Open file once the download is 
completed. 
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Operating 
System Browser Steps 

Mac Firefox 
Google 
Chrome 
Safari 

Go to your downloads by clicking the Downloads icon at the bottom of the 
screen. 

 
In your Downloads directory, select your scanner file from the list of 
downloads.  

 
Note: These steps will be the same for all browsers in Mac. 

For Windows users: 
Once you run or open the downloaded file, follow the steps below to install the scanner driver.  

a) A Scanner Service Drivers Setup dialog box appears. 

 
Click Install to continue with the scanner driver installation. 

b) A User Account Control dialog box appears asking if you would like to allow changes to your 
device. 

Click Yes to continue. 

c) An Installation Completed message appears. 

 
Click Close. 

For Mac users: 
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Once you open the downloaded file, follow the steps below to install the scanner driver. 

a) A Scanner Service Installer window appears with a Scanner Service Installer file. 

 
Right-click on the file and select Open. 

b) A warning message appears. 

 
Click Open to open the Scanner Service driver installer. 

c) The Scanner Service installer appears. 

 
Click Continue. 

d) Click Install to install the Scanner Service driver. 



 

© Finastra  |  Fusion NetCapture  |  Web Client User Guide 11 

 
e) Before the Scanner Service driver can be installed, you must enter your Mac user name and 

password. 

 
Enter your user name and password, then click Install Software. 

f) A successful installation message appears. 

 
Click Close. 

After the scanner drivers are installed, the Launch Installer screen reappears. 



 

© Finastra  |  Fusion NetCapture  |  Web Client User Guide 12 

 
Click Next to proceed to the next step. 

 The Verify Connection screen appears. 

Switch the power to the scanner to ON and connect it to your computer, then click Next. 

Wait while the scanner initializes. 

 
 The Installation Complete screen appears. 

Click OK to exit from the installer. 

 



 

© Finastra  |  Fusion NetCapture  |  Web Client User Guide 13 

The first-time setup process is complete. You can now begin creating a new deposit. See Starting a New 
Deposit. 

Password Change 
On your first login, and when your current password expires, you may be required to change your password 
before you can log in to the application. 

Do the following in the Change Password screen to change your password: 

 In the Old Password field, type your current password. 

 In the New Password and Confirm Password fields, type the new password. 

 Click Submit. 

Note: Your password must comply with certain restrictions as defined by your service organization, 
such as the required use of both numbers and letters. Contact your Service Representative for details. 

You can change your password at any time on the User Preferences screen. See Changing Your Password. 

System Status Notification 
A system status notification message may appear under the following circumstances: 

 You are not able to log in because the server is down. If your service organization has configured 
it, a message will appear to provide more information about the problem and who you should 
contact to resolve the issue. 

 You have successfully logged in, and your service organization has provided a message that has 
information about scheduled downtime or other information that may be useful to you. 

Depending on how your service organization has configured it, this message may appear only when the 
server is down, only one time, or every time you log in. Contact your Service Representative for more 
information. 

How Web Client Licenses Work 
When you log in to Web Client, a license is assigned based on the organization(s) for which you make 
deposits and the PC from which you make deposits. The license tracks usage for billing purposes. For 
example: 

 If a user submits deposits for one organization from one PC, only one license is used. 
 If a user submits deposits for two different organizations from one PC, then two licenses are used. 
 If a user submits deposits for one organization from two different PC’s, two licenses are used. 

The number of accounts for each organization has no bearing on the number of licenses required 
(organizations can use multiple accounts, and as long as deposits are submitted from a single PC, only use 
one license). 

Licenses are automatically generated as needed whenever you log in to Web Client. Your service 
organization is responsible for managing license distribution. 

Understanding Checks and MICR Information 
Before you begin using Web Client to scan checks and make deposits, it is important that you become 
familiar with check terminology and composition. 
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 Items You Can Deposit 
 Understanding Checks 

Items You Can Deposit 
You can use Web Client to deposit a variety of negotiable US dollar items that are drawn on a US bank, 
including personal, business and cashier checks, some traveler’s checks, and money orders. As long as the 
negotiable item is MICR (Magnetic Ink Character Recognition) encoded with a valid 9-digit routing and transit 
number, it can be deposited using the application. If your service organization has decided not to accept cer-
tain types of items, those items will be automatically rejected. 

Note: Web Client does not automatically read the amount on traveler’s checks. 

For every deposit made, only one credit record or deposit slip can be associated with the deposit. Web Client 
cannot split deposits across multiple depository accounts or support the scanning of MICR-encoded coupons. 

If the Bank of First Deposit requires dynamic images for credit items, images can be created by the server 
application when they are sent. 

Understanding Checks 
Checks are also referred to as monetary items. The two terms are used interchangeably throughout this 
document. 

At the bottom of a check is a line of characters encoded in magnetic ink. This line is called the MICR line. The 
pieces of information included in the MICR line may vary from check to check. The following image depicts a 
typical check, with the various parts of the MICR line labeled. 

 

 

 

The following fields may appear in the MICR line of a check: 

Field Symbol Description 

Aux On-Us 
number 

 This number is usually the check serial number. This is often included on 
commercial checks, but never on personal checks. 

EPC number None This is a single-character code that indicates that the item has previously 
been processed electronically. Most items do not have an EPC number. 

Route/Transit 
number 

 This is the routing and transit number, which indicates the location of the 
paying bank. 

Aux On-Us EPC Route/Transit Bank On-Us Encoded Amount (this 
may or may not appear 
on an item) 
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Field Symbol Description 

Bank On-Us 
number 

 This field includes the account number and sometimes the check number 

Encoded amount  This is the amount of the check and does not appear on most items. 

For details about what kinds of information is contained in these fields and how to edit the fields when 
processing items, see Editing Fields on the Item Details Panel. 

Using the Check Scanner 
The process of scanning items varies based on the type of scanner you use. See System Requirements for a 
list of scanners.  

 See the Quick Start Guide provided with your scanner for information on using a specific scanner or consult 
your scanner manufacturer website for more information. 

Deposit Overview 
This section contains information that will help you understand how to use the application to make deposits. 

 Understanding Deposits  
 Making Deposits  

Understanding Deposits 
You can use the application to streamline and simplify your deposit process. Rather than manually 
assembling the items for a deposit and taking them to the bank, you can make your deposit online using the 
Web Client workstation. 

A deposit consists of a group of checks and may optionally contain a deposit slip (depending on how your 
system was configured by your service organization). You can deposit up to 299 items in a single deposit 
using Web Client; however, your service organization may set the limit to fewer items. The total of a single 
deposit cannot exceed $99,999,999.99. After depositing items using the application, you must safeguard the 
deposited checks. Your Service Representative can provide you with more information on how to store or 
destroy the deposited monetary items. 

Note: Web Client can only make deposits to service organizations configured within the system. For example, 
if Web Client has only been configured for your accounts through First National Bank but you also have 
accounts through Second National Bank, you can use Web Client to deposit funds into First National Bank but 
not into Second National Bank. 

Making Deposits 
The following is an overview of the basic procedure you will use when making a deposit with Web Client: 

 Group the checks together for the deposit and prepare them for scanning. Place item(s) for the deposit 
in the check scanner. 

If you are using a deposit slip, scan it as the first item in the deposit. If you do not scan it as the first 
item, you will have to go through an extra process to adjust and balance the deposit. See Changing an 
Item’s Type. 

 Log in to the application and begin a new deposit. 

 If you are able to make deposits to more than one account, choose the account to which you are 
making this deposit. 
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 If your system is configured to require a control balance, enter the expected total amount of the 
deposit. 

 Click Scan. 

The system scans the item(s) for the deposit and displays the first item for review. 

 Verify the scanned MICR information. Edit any erroneous fields (which are outlined in red with red 
text), and enter any information that was not automatically read. 

 If there are any problems with the image, reject and reprocess the item. 

 When you are done editing the item, go to the next item in the grid by pressing Tab or clicking on the 
next row. 

If there are any problems with the item, the fields in error are highlighted. Go back to the item and edit 
the erroneous fields. 

 Repeat steps 6-8 until you have accepted all the items that need repair. 

 Submit the deposit. 

This is a general overview of the procedure. See Making Deposits for detailed steps on completing each part 
of the deposit procedure. Also, see the quick reference guide for your scanner for more detailed information 
on how to scan items with your particular scanner. 

Exiting Web Client 
To exit the Web Client application, click the Logout tab at the top right corner of the application screen. 

If any deposits are still being transmitted to your service organization when you log out of the Web Client 
system, or if an error occurs and a deposit is not successfully completed before the system is closed, the 
transmission will automatically be suspended and resumed the next time you log in to the application. 

Suspended deposits remain in the system for the amount of time designated by the Web Client administrator. 
Once that time limit is reached, any suspended deposits are deleted. It is important to be aware of this time 
limit to avoid unintentionally allowing any suspended deposits to be deleted. 

Note: If you need more time to complete a deposit, contact your System Administrator, and the time can be 
extended. 

For more information about suspended deposits, see Resuming a Suspended Deposit. 
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3 Making Deposits 
You may use the following procedures and concepts when making deposits: 

 Understanding Deposit and Item Numbering 
 Verifying and Editing Items 
 Balancing the Deposit 
 Completing the Deposit 
 Canceling a Deposit 
 Resuming a Suspended Deposit 

Starting a New Deposit 
To start a new deposit, do the following: 

 From within Web Client, click the Deposit tab. For information on logging in, see Standard Login 
Process. 

 
 Insert the deposit items into the input slot of the scanner as directed by the Quick Start Guide for the 

scanner or the scanner’s documentation. 

Note: If your service organization has configured this account to use a deposit slip, you must scan it 
as the first item in the deposit. If you do not scan it as the first item, you will have to go through an 
extra process to adjust and balance the deposit. 

 In the Select Account field, search by account name or number and select the customer account to 
which you want to make a deposit. 

Note: The account list can be sorted by clicking on the column headers. 

 Depending on how the account you chose has been configured by your service organization, you will 
receive one of the following prompts: 

Configuration What you will see Steps to take 

Deposit slip The system prompts you to 
place the deposit slip as the 
first item in the scanner. 

Click Scan. 
 

Optional Deposit Slip The system prompts you to 
begin scanning with a deposit 
slip or without a deposit slip. 
 

Click Deposit Slip if you are 
using a deposit slip. 
Click No Deposit Slip if you are 
not using a deposit slip. 
Click Scan. 
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Configuration What you will see Steps to take 

Control Balance The system prompts you to 
enter the total amount of the 
deposit. 

Enter the control balance and 
click Scan. 

Deposit Slip and Control 
Balance 

The system prompts you to 
enter a control balance and 
place the deposit slip as the 
first item in the scanner. 

Enter the control balance and 
click Scan. 

Control Balance and Optional 
Deposit Slip 

The system prompts you to 
enter a control balance, and to 
begin scanning with or without 
a deposit slip. 

Enter the control balance. 
Click Deposit Slip if you are 
using a deposit slip. 
Click No Deposit Slip if you are 
not using a deposit slip. 
Click Scan. 

No Control Balance or Deposit 
Slip 

There are no prompts. Click Scan. 

Note: When entering a control balance value, if you do not enter a decimal, the application assumes a 
decimal is present at the end of the entered amount. For example, if you enter 1000, the application 
reads the amount as $1000.00. If you enter a decimal but do not enter both digits after the decimal, 
the application fills in the remaining digits as zeroes. For example, if you enter 1000., the application 
reads the amount as $1000.00. 

After you select the account you want the deposit sent to, an option to receive email notifications is available. 
To receive email notifications, enter the email address you want the notification sent to in the E-mail address 
panel. Next, confirm the email address is correct by re-entering it. You can choose to enter your email 
address now or you can enter it later in the User Preferences tab. Once you have entered your email address, 
it is stored by the system, and you will not be prompted to enter it again. 

 

Scanning begins and the Process Checks screen appears. You can edit items in the Scanned Items grid or 
on the Item Details panel. Continue with the following section, Process Checks Screen Overview for more 
information. 

Process Checks Screen Overview 
The Process Checks screen is the screen appears once you have started a new deposit. It displays images 
and summary information for all items scanned for the deposit. The Scanned Items grid row that is currently 
selected is shaded. Items with errors have a red circle with an exclamation point  in the Status column.  
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Scans items 

Item Details 
panel 

Scanned Items 
panel 

Deposit-level custom 
fields – if configured 

View front or back of 
check image 

Zoom in or out of the 
check image Image display area Deposit dashboard 

Submit or Cancel the deposit 
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Information Displayed on the Screen 

There are three types of item information that can be displayed on the Process Checks screen. 

 Deposit-level custom fields: Displays information in the Deposit Fields grid for a deposit. 
 Item Details panel: Allows you to edit each item in a deposit. 
 Scanned Items grid: Displays information about items in the deposit such as amount, MICR fields, 

or item-level custom fields. 

Deposit Fields 

If your service organization has configured it, up to four deposit-level custom fields can appear in the Deposit 
Fields panel. Deposit-level custom fields may be configured as required or optional. If they are required, you 
will not be able to complete the deposit without entering the required information. 

 

Item Details Panel 

The Item Details panel allows you to view and edit the information for one item at a time. You can use this 
view to focus on just the items that need to be repaired. For information about editing items on the Item 
Details panel, see Editing Fields on the Item Details Panel. 

The Item Details panel can be collapsed, expanded, or resized. The application will automatically save any 
adjustments you make to the Item Details panel. To collapse or expand a panel, click on the arrow to the left 
of the panel name. 

 

 

 

 

 

 

 

Scanned Items Grid 

The Scanned Items grid allows you to view, edit, and delete items in the deposit. Information that is displayed 
on the Scanned Items grid includes MICR information from the check and may or may not include the payer 
name and custom fields, depending on how your service organization has configured it. For information about 
editing items on the Scanned Items grid, see Editing Fields on the Scanned Items Grid. 

To display or hide any fields in the Scanned Items grid, left mouse-click on the right corner of a column 
header, select Columns, and select columns for display in the drop-down list. Columns in the grid can be 

Enter MICR information 
and the item amount 

Required custom fields are 
outlined in red 

Item-level custom fields 

Go to the previous 
item 

Go to the next item that 
needs repair 

Go to the 
next Item 
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rearranged and resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort 
Ascending or Sort Descending. 

 

 

 

 

 

 

 

The Scanned Items grid can be collapsed, expanded, or resized. You can collapse the Item Details panel and 
edit all scanned items in the resized grid or you can collapse the Scanned Items grid and edit scanned items 
from the Item Details panel. To collapse or expand a panel, click on the arrow to the left of the panel name. 

Filters can be applied on the Item Status column to display or hide erroneous items. 

 

Understanding the Deposit Dashboard 
The Deposit Dashboard appears in the upper-right corner of the Process Checks screen. The Dashboard 
provides information about the deposit you are processing. 

  

The following information appears in the Deposit Dashboard: 

 Account: The account number the items are being deposited to. 

Deletes the item 

Displays item grid 
information 

Displays item errors that 
require correction before 
submitting the deposit 

Hide or display 
columns 

Sort columns in ascending or 
descending order 
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Note: The account number may be masked depending on the settings configured by your service 
provider. 

 Total Amount: The sum of the debit items that have been successfully scanned. 
 Control Balance: The sum of the debit items that you entered for the deposit when starting the 

deposit. This field appears only when a control balance or deposit slip is used. 
 Difference: The difference between the Total Amount and Control Balance. This field appears only 

when a control balance or deposit slip is used. 
 Items in Deposit: Number of items currently scanned for this deposit. 
 Items Needing Repair: Number of items in which the system has found errors that need user 

intervention. 
 Items Not Yet Viewable: The number of items that have been scanned but are still being processed 

and sent to the server. 

The information displayed in the Dashboard depends on the configuration of the account. For example, if the 
account is configured not to use a control balance or deposit slip, the Control Balance and Difference entries 
will not appear in the Dashboard. The system updates the Deposit Dashboard as scanned items are validated 
and amounts are added for each item. 

When all items are processed and validated (have a green checkmark  in the Status column), and the Total 
Amount is equal to the Control Balance amount so that the Difference is zero (i.e., the deposit is in balance), 
the deposit can be submitted. If the control balance you entered is incorrect and does not equal the Total 
Amount, a new control balance can be entered in the Deposit Dashboard. 

Understanding Deposit and Item Numbering 
As you scan items and create deposits, the application assigns identification numbers to each item and 
deposit. The numbers are assigned sequentially.  

The application supports Client-side and Server-side IDs for each item and deposit. Client-side IDs are 
assigned to a deposit and items when they are created, while Server-side IDs are assigned after data is 
submitted to the server. Different areas of the application will indicate whether it is a Client-side or Server-side 
ID. 

 Deposit Numbering 
 Item Numbering 

Deposit Numbering 
The number for a new deposit is assigned based on the number of the last deposit that was created by any 
Web Client user. For example, say you have just completed deposit number 3. Before you start your next 
deposit, another user in your organization initiates a deposit. In this case, the other user’s deposit is 
numbered 4. Your deposit Client-side ID will be numbered 5. When you submit your deposit, it will also 
receive a Server-side ID that is different from the Client-side ID. For example, your Server-side ID can be 
numbered 546 after you submit a deposit.  

Both Client-side ID and Server-side ID will be displayed in Reporting for tracking purposes.  

Item Numbering 
When items are scanned, the item numbers are assigned based on deposit, starting at 1 for each new 
deposit, and continuing sequentially. The item is also assigned a Client-side ID number that makes each item 
unique to your organization. The unique Client-side ID number is not displayed on the Process Checks screen 
but is displayed on the Deposit Confirmation screen and in reports. 
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Similar to deposits, each item is assigned a Server-side ID after a deposit is submitted. You will be able to 
view and track this ID in reports. 

Verifying and Editing Items 
Use the Scanned Items grid and the Item Details panel on the Process Checks screen to verify and edit the 
information for a scanned item. The scanner captures the check image and the system attempts to read the 
MICR line information and the courtesy amount. Some manual editing may be required. See the following 
instructions for verifying and editing items: 

 Editing Item Information 
 Changing an Item’s Type 
 Viewing Item Images 
 Reviewing Duplicate Deposits 
 Rejecting Items 

Editing Item Information 
If the scanner is able to read the information in the MICR line, the scanned information appears in the fields 
below the Item Details panel. For an example of the scanned fields, see the figure below. 

 

 

 

If a scanned field is incorrect, the field has a double red border and displays bold, red text in the Scanned 
Items grid to indicate that there is an error. 

See the following topics about editing item information: 

 Automatic Approval 
 Making Changes to an Item’s Data 

 Navigating Fields Using Shortcut Keystrokes 

Automatic Approval 

In cases where an item is scanned and validated by the application and requires no user intervention, the 
system may approve the item. When an item has been validated and accepted as error-free, a green 
checkmark   appears in the Status column for that item on the Scanned Items grid. 

Aux On-Us EPC Route/Transit Bank On-Us Encoded Amount (this 
may or may not appear 
on an item) 
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Making Changes to an Item’s Data 

After a check is scanned, MICR information from the check is automatically read and populated in the 
Scanned Items grid. The first scanned item’s information will be populated in Item Details panel. You can edit 
each item from either the Item Details panel or the Scanned Items grid, and you can collapse one of them to 
see more data. 

Note: When item information is edited in the Scanned Items grid, the same item information is simultaneously 
updated in the Item Details panel. 

As a general rule, fields on the Scanned Items grid and Item Details panel accept only basic ASCII 
characters, or those characters found on your keyboard. Some fields have additional restrictions; for example, 
they may not accept certain special characters. Any such restrictions are specified in the following instructions 
for editing the fields. 

Editing Fields on the Item Details Panel 

The Item Details panel displays one scanned item at a time and allows you to edit all of the MICR information 
for that item and any custom fields configured by your service organization. The payer name will also be 
displayed if your service organization has configured it.  

Custom fields are displayed and editable in the panel. For more information on custom fields, see Editing 
Custom Fields. 

Note: When item information is edited in the Item Details panel, the same item information is simultaneously 
updated in the Scanned Items grid.  

The following table explains the MICR fields and how to identify them on an item. 

Field Symbol Description 

Aux On-Us number  This is usually the check number. It is often included on commercial 
checks, but never on personal checks. The format of this field varies, and 
may contain numbers, spaces, and dashes. It is denoted by the on-us 
symbol. 
The on-us symbol is not displayed in the item grid.  

EPC number None This is a code assigned to the item if it has previously been processed 
electronically. This is usually blank, but if present, it appears between the 
aux on-us number and route/transit number. 

Route/Transit 
number 

 This is the eight- or nine-digit route/transit number for the bank. This field 
is required. 
Eight-digit route/transit numbers are allowed only for deposit slips. 
Monetary items must have a nine-digit route/transit number. The 
route/transit number starts with a 0, 1, 2, or 3 and may contain only 
numbers, unless it is an eight-digit route/transit number, in which case it 
may contain a dash (entry of the dash is optional). It is denoted by the 
routing symbol. The routing symbol does not have to be included in the 
scanned value for this field. 
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Field Symbol Description 

Bank On-Us 
number 

 This includes the account number and in some cases the check number. 
Account numbers included in the bank on-us field vary in format, and may 
include numbers, spaces, or dashes. Enter the account number exactly as 
it appears on the item. It is denoted by the on-us symbol. 
The on-us symbol is displayed as a forward slash (/) in the Scanned Items 
grid and Item Details panel. You must enter a capital O or a forward slash 
(/) in place of the on-us symbol. 
Note for deposit slips: Depending on how your service organization has 
configured the account number, you may or may not be required to enter 
forward slashes (/) in place of on-us symbols for deposit slips. If the 
configuration requires forward slashes to appear in place of on-us 
symbols and they are not read by the scanner, the bank on-us field for the 
deposit slip will fail validation. You must enter forward slashes in place of 
the on-us symbols. 

Amount  This is the amount of the item. You do not need to enter an amount if an 
encoded amount (denoted by the symbol at the left) is scanned of if the 
correct amount is read via CAR (courtesy amount recognition). You 
should edit the scanned amount if it is incorrect. 
This field may contain only numbers and a decimal point. 
The amount for an individual item may not exceed $99,999,999.99. If you 
do not enter a decimal in the item amount, the application assumes a 
decimal is present at the end of the entered amount. For example, if you 
enter 1000, the application reads the amount as $1000.00. If you enter a 
decimal but do not enter both digits after the decimal, the application fills 
in the remaining digits as zeroes. For example, if you enter 1000., the 
application reads the amount as $1000.00. 

Every time you leave a field after editing (using any of the available navigation methods) it is validated to 
determine whether it can be accepted or whether it still has errors. If the value is invalid, it will be highlighted 
with a double red border. You can move the mouse over the field to see the error description. When the whole 
item has been validated and accepted as error-free, a green checkmark  appears in the Status column for 
that item on the Scanned Items grid. If there is an error, a red circle with an exclamation point  appears 
next to the item number. After making necessary changes, do one of the following: 

 To open the previous item, click Previous Item. 
 To open the next item, click Next Item. 
 To open the next item that needs repair, click Next Repair. If you made changes to an item and it 

still has errors, it will continue to reappear in the cycle of items (as you click Next Repair) until it has 
no errors.  

Once a field has been edited, a red triangle in the corner of the field will indicate that it is in the process of 
being saved. 

Editing Fields on the Scanned Items Grid 

The Scanned Items grid allows you to edit all item data and the custom fields (if configured and displayed) for 
each item in the deposit.  

Note: When item information is edited in the Scanned Items grid, the same item information is simultaneously 
updated in the Item Details panel. 

Custom fields are not displayed by default, but a set of displayed columns can be modified by clicking on the 
column’s header and selecting columns for display. For more information on custom fields, see Editing 
Custom Fields. 
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You may need to manually enter the amount for each item unless it is included in the MICR line of the check. 
However, if CAR capability has been enabled, the system will attempt to read the courtesy amount area of the 
check and place that amount in the amount field. 

Editing Payer Name 

Depending on whether or not your service organization has configured it, payer name may or may not appear 
on the Scanned Items grid and the Item Details panel. You can enter the company name or the payer name in 
the Payer field. Payer name will be auto-populated by looking up previous transactions with the same routing 
number and account number.  

Editing Custom Fields 

In addition to the MICR and amount fields, there may be up to 12 other custom fields that have been defined 
by your service organization. Custom fields are hidden by default on the Scanned Items grid. You can make 
them visible by clicking any column header and selecting custom fields for display. In the Item Details panel, 
custom fields are always visible. 

If your organization is configured with many custom fields, editing items in the Item Details panel may be 
easier. If your organization is configured with few or no custom fields, editing items in the Scanned Items grid 
may be easier. 

Custom fields may be required or optional. If they are required, they will have an asterisk next to the field, and 
you will not be able to accept the item without entering the required information. If your service organization 
has configured it to auto-populate custom fields, then the application will look up previous transactions with 
the same routing and account number, and automatically populate the custom fields using previous entries. 
Contact your Service representative for details about how to use these fields. 

Changing an Item’s Type 

When items are scanned, they are assigned a type. There are two types of items: 

 DS = deposit slip 
 DR = debit record (monetary item) 

The item type appears in the Type drop-down list in the Item Details panel. 

Note: The option to assign the DS type to an item is ONLY available if your service organization has 
configured your workstation to use deposit slips. 

You should scan the deposit slip as the first item in a deposit, and as such, the first item is automatically 
assigned an item type of DS. However, if you accidentally scan the deposit slip later in the deposit, you can 
change the items’ types so that the deposit slip shows the correct item type. 

There can only be one DS type item in a deposit. Do the following to assign a new item the DS type: 

 To change the current DS type item to a DR type item, click on the Type drop-down list and select DR 
from the drop-down box. 

 
 

 

 

 Next, locate the item to which you want to assign a DS type. Click in the Type column for that item, 
and then select DS from the drop-down box. 

The Type drop-down menu lets you select 
whether the item is a deposit slip (DS) or debit 
record (DR). 
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Note: When you change an item’s type, the amount of that item is either added to or subtracted from the 
deposit total, as appropriate. Pay attention to the effect that changing an item’s type has on the deposit total 
for balancing purposes. 

Navigating Fields Using Shortcut Keystrokes 

Many of the functions you perform in Web Client can be performed with keystrokes. Along with using your 
mouse to move between fields, the following keyboard strokes help you navigate fields in the Item Details 
panel and in the Scanned Items grid: 

Keyboard Strokes Action 

Tab Allows you to navigate and edit data mouse-free on the page. It is similar to 
other web applications you might experience. 
This is convenient for editing erroneous fields in the Item Details grid. First, turn 
the grid into data editing mode by double mouse-clicking in any cell in the grid, 
which makes the cell editable. 
Then use the Tab key to navigate from cell to cell to edit erroneous values. 

Shift + Tab The Shift + Tab combination functions the same as the Tab key, but in reverse 
order.  

Enter Validates the entry in the current field but does not navigate to the next field. 

Alt + ! Logs out of Web Client. 

Alt + u  Opens the User Preferences screen. 

Alt + 0 Initiates the Scan function. 

Alt + + Zooms in on the item image (all). 

Alt + * Zooms into the Courtesy Amount area of the image. 

Alt + Shift + 7 Zooms into the MICR line area of the image. 

Alt + - Zooms out to the full image. 

Alt + y Views the front of the item. 

Alt + q Views the back of the item. 

Alt + Shift + 4 Opens the Edit Control Balance dialog box. 

Alt + # Completes the deposit. 

Alt + n Cancels the deposit. 

Alt + i Navigates to the Item Details panel. 

Alt + 7 Brings the previous item in the Item Details panel. 
Note: This keystroke combination can only be used on the main keyboard. 

Alt + 8 Brings the next item in the Item Details panel. 
Note: This keystroke combination can only be used on the main keyboard. 

Alt + 9 Brings the next item for repair in the Item Details panel. 
Note: This keystroke combination can only be used on the main keyboard. 

Alt + g Navigates to the Scanned Items grid. 
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Keyboard Strokes Action 

Arrow Keys In the field, moves the cursor one character to the right or left. The up and 
down keys are not functional in the field. 

Alt + k Displays erroneous items. 
Note: Using this keystroke combination a second time will restore the whole list 
of items. 

Alt + 5 Deletes the item selected in the Scanned Items grid. 

Viewing Item Images 
When you scan an item, the front image appears in the main part of the window. 

To view the front or back of an image, select the corresponding button at the top of the window.  

Note: If the scanner is equipped with an inkjet printer and you or your service organization have configured 
your application to print text on items, the scanner prints some additional information such as the deposit 
number and item number on the back of each item. This provides a reference for you when managing paper 
items. The printed text can be configured by settings you make on the User Preferences tab, or it can be 
controlled by your service organization. See Configuring Text Printed on Items for more information. 

Zooming in On an Image 

To zoom in on an image, click the Zoom button: A menu appears giving you the option of zooming to view 
the full-size image, just the amount, or just the MICR line. 

 

The selected image or portion of the image is enlarged for better readability. 

To view other areas of the image, select any of the zoom options and grab the image with the mouse pointer. 
Once you have grabbed the image you can drag it to the area you would like to view in the image viewer 
window. 

Click the zoom standard button:  to return to the default image scan size. 

Reviewing Duplicate Deposits 
If the application thinks a check is scanned more than once, a possible duplicate message appears in the 
Messages column in the Scanned Items grid. You will need to review both checks to determine if the current 
check is a duplicate of the previously scanned check. If they are duplicates, you will need to reject the current 
check. If they are no duplicates, you can accept the check. 

To review a duplicate deposit, do the following: 

 Click the Possible Duplicate Item Found link under the Messages column.  

A Review Duplicates screen appears with the previously scanned check and the current check. 
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 Compare both checks to determine if they are the same check. If they are not, click No and continue 

with the deposit. If they are the same, click Yes. A Cancel Item dialog box will open. 

 Click Yes, Cancel Item to cancel the duplicate item. 

In the Scanned Items grid, the row for the duplicate item will be grayed-out. 

Rejecting Items 
You may need to reject items for the following reasons: 

 There were problems with the initial scanned image. For example, you should reject an item if it 
was scanned in upside-down or backwards, is folded or crooked, or if two items were scanned 
simultaneously. Likewise, if the initial scan produced MICR line errors, you can reprocess it by 
rejecting it from the deposit and then rescanning it. 
For examples of possible scanning problems and how to remedy them, see User Administration 

The Admin tab allows an organization to administer their users within their home organization. An admin can 
create new users, assign user roles, reset user passwords, and clone existing users. Depending on the 
privileges your service provider has configured for your organization, the Admin tab may not be accessible. 

Note: The Admin tab does not support administration of users across multiple orgs. 

This chapter contains the following information: 

• Searching for a User 
• Creating a User 

 

• Editing a User 
• Cloning a User  
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Searching for a User 
You can search for a user by entering the user name, email address, or user status in the Search Users text 
box and the grid will automatically filter a list of users as you type.  

 

You will only see users that you have access to from your home organization. Users from other organizations 
will not be displayed on Admin tab even though you might have access to them.  

 

The list of users contains the following information: 

Column Description 

User Name The user name of the user. 

First Name The first name of the user. 

Last Name The last name of the user. 

Status The status of the user. The status can be Active or Inactive. 

Email for Mobile 
Alerts 

The email address of the user for email notifications about deposits submitted from 
the Mobile application. 

Deposit Review 
Limit 

Deposit limit threshold for the user that will require a secondary approval (Dual 
Control) before being submitted to the financial institution. See Reviewing Deposits 
for more information. 
Note: This field will only be displayed if the Dual Control rule is active. 

Clone User Allows you to create a new user by cloning an existing user. See Cloning a User for 
more information. 

Note: To display or hide any fields in the grid, left mouse-click on the right corner of a column header, select 
Columns, and select columns for display in the drop-down list. Columns in the grid can be rearranged and 
resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort Ascending or 
Sort Descending. 

Creating a User 
To create a user, do the following: 

 On the Admin screen, click on the New button. 
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 The Create User screen appears with the Profile tab selected.  

 
Enter the following information into the fields on the Profile tab: 

Field Description 

User Name The user name that will be used to login to Web Client. 
Note: Once a user’s user name is created and saved, it cannot be changed. 

First Name The first name of the user. 

Last Name The last name of the user. 

Password The default password for the user. 
Note: This field is only displayed if applicable for your organization. 

Confirm Password The confirmation of the default password previously entered. 
Note: This field is only displayed if applicable for your organization. 

Email for Mobile 
Alerts 

The email address that will be used for mobile deposit alerts.. 
Note: This field is only displayed if your organization is configured for Mobile 
deposits. 

Deposit Review 
Limit 

The deposit limit threshold for the user that will require a secondary 
approval (Dual Control) before being submitted to the financial institution.  
Note: This field will only be displayed if the Dual Control rule is active. 

Note: Required fields are marked with an asterisk. 

 Click Next to create the user’s profile and advance to the Assign Roles tab.  

 On the Assign Roles tab, select the check box next to the role that you want to assign to the user in 
the Assigned Roles section.  

Note: The list of roles will not exceed the admin’s privileges.  
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 The information displayed in the Account Access column depends on the displayed role. Some roles 

can be assigned at the account level and other roles can only be assigned at the customer level.  

The account access levels are: 

− Customer level: The user will have access to all accounts within their organization. If a new 
account is added to the organization at any time, users will automatically get access to that 
account.  All Accounts will be displayed in the Account Access column for each customer 
level role. 

− Account level: The user will have access to the specific account selected. If a new account is 
added to the organization at any time, user roles need to be updated to access that account.  
All account levels roles will have a drop-down list of available accounts to assign to the user 
role. 

 
 Click Done when you finish assigning roles to the user. 

The roles are now assigned to the new user.  
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Editing a User 
The profile and assigned roles can be updated when editing a user. On the user’s profile, all information 
except for the user name can be edited. Assigned roles and accounts can be added or removed. 

To edit a user, do the following: 

 On the Admin screen, click on the user name in the grid that you want to edit. 

 The Update User screen appears.  

 
You can edit the following fields on the Update User screen: 

Field Description 

First Name The first name of the user. 

Last Name The last name of the user. 

Password The password for the user. 
Note: This field is only displayed if applicable for your organization. 

Confirm Password The password a second time to confirm it is correct. 
Note: This field is only displayed if applicable for your organization. 

Status The status of the user. The status can be one of the following: 
• Active:  The user is able to log in to the application. 
• Inactive:  The user is deactivated and cannot log in to the application. 

You can set any user into Inactive status if needed. 
Note: If a user is locked out of the application due to failed attempts to 
login or due to inactivity, the user status will be displayed as Inactive. 
You can restore the user’s status to Active at any time. 

• Deleted: The user will no longer be displayed in the list of users but will 
still be visible in the reports associated with the deposits made by this 
user.  
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Field Description 

Email for Mobile 
Alerts 

The email address for the user to receive mobile alerts regarding deposits 
made from the Mobile application. 
Note: This field is only displayed if your organization is configured for Mobile 
deposits. 

Deposit Review 
Limit 

The deposit review limit amount for the user.  
Note: This field will only be displayed if the Dual Control rule is active. 

 Click Next to save the changes and advance to the Assign Roles screen.  

Changes to the user’s profile will be saved.  

 On the Assign Roles screen, you can do the following: 

− Delete a role: Uncheck the check box next to the role in the Role column to delete a role. 
− Add a role: Select the check box next to the role in the Role column to add a role. 
− Remove an account from a user’s access: Select the required role in the Role column and 

uncheck the check box next to the account in the Accounts section to remove an account 
from the user’s access. 

− Add a new account to a user’s access: Select the required role in the Role column and select 
the account in the Accounts section that you want to add to the user access.  

 Click Done to save the changes. 

Changes to the user’s assigned roles and accounts will be saved. 

Cloning a User 
A new user can be created by cloning an existing user from the Admin tab.  

To clone a user, do the following: 

 In the Clone User column on the Admin screen, click on the Clone icon  next to the user to be 
cloned. The Cloning User screen appears with the Profile tab selected.  
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Enter the fields on the Profile tab. See Creating a User for more information about the fields on the 
screen. 

Note: If your organization has been configured for Dual Control, the Deposit Review limit field is the 
only field that will be populated with the amount from the cloned user. All other profile information is 
unique to the new user. 

 Click Next to create the user profile and advance to the Assign Roles tab. The Assigned Roles tab will 
be prepopulated with the roles from the cloned user.  

 
Make necessary changes to the displayed roles or save them as is by clicking the Done button. 

Note: Roles are not saved for the new user until you click Done. 

The new user has now been created. 
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Troubleshooting. 
 You suspect the item is fraudulent, or if there are problems with the item that will prevent it from 

being deposited, such as a missing signature, etc. 

When rejecting an item, you must reject the scanned item in the deposit and you must also locate the paper 
item and remove it from the deposit. 

To reject an item, do the following: 

 Click the Delete icon:  on the items row. The Reject Item confirmation dialog box opens. 

 Click Submit. 

In the Scanned Items grid, the row for the rejected item is stricken through. 

 In the stack of paper items, locate the item you just rejected and remove it from the deposit. 

If you want to rescan the item, place it in the input slot of the scanner and click the Scan button, then process 
the item as usual. 

Reasons for Automatic Item Rejections 

Web Client may automatically reject items for the following reasons, depending on the rules set by your 
service organization: 

 An item’s scanned image does not meet the image quality threshold configured by your service 
organization. 

 An item has an incorrect route/transit number, or a route/transit number that is configured as invalid 
or unacceptable. 

 There are problems reading necessary data fields in the item; for example, there is no MICR line, 
or certain fields are unreadable. 

 The item puts the deposit over the maximum dollar amount limit, which is $99,999,999.99. 

In addition, items may be rejected based on other rules as configured by your service organization. 

When an item is automatically rejected, the row containing the item information appears grayed-out. 

Balancing the Deposit 
When you have scanned all the items for the deposit and are ready to submit it, you must first ensure that the 
deposit balances—that is, that the control balance amount or deposit slip amount equals the total of all the 
monetary items you scanned. 

There are two means by which you can balance your deposits: a control balance or a deposit slip. Your 
service organization may have configured your system to use one or both of these means, or neither of them. 

When you scan a deposit slip or provide a control balance, that amount appears in the Control Balance field 
of the Dashboard in the upper right corner of the Process Checks screen. If you provide both, whichever 
amount is greater appears in the Control Balance field. The Dashboard also displays the difference between 
the total amount and either the control balance or deposit slip amount (whichever is greater). The difference 
must be zero in order to submit the deposit. 

If you are using a control balance and a deposit slip, the deposit slip amount and deposit total must match 
before the deposit is considered in balance. You can bring the deposit into balance by adjusting the deposit 
slip amount or a check amount.  

There are three ways you can modify the deposit so that it balances: 

 Changing an Item’s Amount 
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 Changing the Control Balance 
 Changing the Deposit Slip Amount 

Changing an Item’s Amount 
Before changing the control balance or deposit slip amount for the deposit, you should make sure all the 
items in the deposit have the correct amount. For example, if you are using CAR, it is possible that an item 
amount was misread. Double-check all the item amounts in the deposit to ensure they are entered correctly. 

To change an item amount, locate the row that contains the item you want to correct and edit the amount. 
Once the Difference field in the Dashboard is zero, you can complete the deposit. 

Changing the Control Balance 
You may want to change the control balance when you have scanned and edited all of the monetary items for 
the deposit and have determined that the initial control balance you entered was incorrect. 

To edit the control balance, enter the desired amount in the Control Balance field of the Deposit Dashboard. 
Once the Difference field is zero, you can complete the deposit. 

 

Changing the Deposit Slip Amount 
You may want to change the deposit slip amount if you accidentally entered the wrong amount when 
scanning the deposit slip. 

To change the deposit slip amount, locate the row that contains the deposit slip information and edit the 
amount just as you would any other item in the deposit. Once the Difference field in the Dashboard is zero, 
you can complete the deposit. 

Completing the Deposit 
Before completing the deposit, check the following: 

 Ensure the status for all of the items in the deposit have a green checkmark in the status column. 
 If you are using a control balance or deposit slip, check to make sure the item total amount 

matches the control balance or deposit slip amount before completing the deposit. 

Deposits must balance before you can submit them. If the deposit does not balance, you can 
change the individual item amount, the control balance, or the deposit slip amount until it balances. 
See Balancing the Deposit for details. 

 If the deposit is required to use a deposit slip, there must be one, but no more than one, DS type 
item in the deposit. 
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 If you have exceeded the deposit activity limit configured by your service organization, an 
Exceeded Limit error message appears. You have the option to remove items and re-submit your 
deposit, suspend the deposit and submit it later, or abort the deposit. The limits are on total dollar 
amount of the deposit or number of items, so if you want to submit the deposit then you can 
attempt to reduce the dollar amount or the number of items. 

Once the above requirements have been met, click Submit Deposit to finish the deposit and view the 
confirmation page. 

Deposit Submission Workflow 
The application completes validation according to the rules configured by your service organization. If any 
changes are required, the system prompts you to go back and edit the deposit. After completing any required 
changes, click the Submit Deposit button again to finish the deposit. 

Following is a diagram of the deposit submission workflow: 

 

Complete Deposit Screen Overview 
The Complete Deposit screen appears once you have submitted a deposit. It contains the following 
information about a deposit: 

 Deposit summary 
 Deposit-level custom fields 
 Download options 
 Item details 
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Once you have finished viewing the information on the Complete Deposit screen, you can either start a new 
deposit or download the confirmation page. To start a new deposit, click the Start New Deposit button, which 
will take you back to the Start Deposit screen. For more information on downloading the confirmation page, 
see Downloading the Deposit Confirmation.  

Deposit Summary 

The deposit summary includes details about the deposit and any deposit-level custom fields that have been 
configured. 

It includes the following information: 

 Customer: The customer name. Depending on how your service organization has configured it, this 
field may or may not be configured. 

 Account: The name of the account. 
 Account Number: The account number the deposit was submitted to. 
 Deposit Total: The total amount of all check items in a deposit. 
 Items in the Deposit: The total number of items in a deposit including credit items. 
 Submitted Date: The date the deposit was submitted. 
 Submitted By: The name of the user who submitted the deposit. 
 Deposit-Level Custom Fields: If it is configured, deposit-level custom fields will be displayed next to 

the deposit summary. 

Deposit Items 

The Deposit Items grid is located under the deposit summary and contains details about items in a deposit. It 
includes the following information: 

 Item: The client-side item ID that is associated with an item in a deposit. 
 Type: The scanned check (Debit Record) or Deposit Slip. 
 Aux on-us: The aux-on-us number found on the check. 
 R/T: The route/transit number for the bank. 
 EPC: The code assigned to an item if it has previously been processed electronically from the 

check MICR line. 
 Bank on-us: The account number and, in some cases, the check number. 
 Amount: The amount of the item. 
 Custom fields: These fields may vary, depending on how your service organization has configured 

it. 
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To display or hide any fields in the Deposit Items grid, left mouse-click on the right corner of a column header, 
select Columns, and select columns for display in the drop-down list. Columns in the grid can be rearranged 
and resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort Ascending 
or Sort Descending. 

Downloading the Deposit Confirmation 
If your service organization has configured it, the deposit confirmation page can be downloaded in CSV or 
PDF format. 

To download the deposit confirmation, click one of the following download formats from the Download drop-
down list: 

 Download CSV: Includes the deposit and item details 
 Download Front PDF: Includes deposit and item details with front images 
 Download Front & Back PDF: Includes deposit and item details with front and back images 

Note: Another way to view a summary of your deposit is by going to Reporting > Reports and generating a 
report by deposit with the date range of the deposit. 

Deposit Transmission 
After you submit a deposit, it is sent to your service organization for processing. The time required to transmit 
the deposit depends on the speed of your Internet connection and the size of the deposit. 

Submitted deposits are sent to a queue for processing. The amount of time required to process the deposit 
depends on the number of deposits in the queue. Your deposit may or may not be processed on the same 
day it is submitted, depending on your service organization’s processing times and policies. Contact your 
service organization for details. 

Canceling a Deposit 
If you do not want to complete a deposit, you can click Cancel Deposit to delete the deposit. This will cancel 
the deposit, and no items will be deposited. 

To cancel a deposit, do the following: 

 On the Process Checks screen, click Cancel Deposit.  

A confirmation page appears with a deposit summary of the deposit that was canceled. 

 
 To start a new deposit, click the Start New Deposit button. 
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Resuming a Suspended Deposit 
A suspended deposit is a deposit that is sitting incomplete on the Web Client workstation. There are situations 
in which you may have a suspended deposit: 

 If connectivity to the server is lost, the deposit is automatically suspended and saved. 
 If the application receives an error that causes it to close without completing the deposit, the 

current deposit is automatically suspended and saved. 
 If you close your browser before completing a deposit, the deposit is automatically suspended and 

saved. 
 If the system detected that you have not used the application for a long period of time, your session 

will be automatically terminated and you will have to log in again to continue working on your 
deposit. 

When a deposit is suspended, it must be processed before you can start a new deposit. When you log in to 
the application, it automatically finds whether the suspended deposit exists and displays it in the Process 
Checks screen. Continue processing as usual, either adding more items to the deposit, or finishing the 
deposit by clicking the Submit Deposit button. 

Note: The Web Client administrator sets a specific time limit for suspended deposits to remain in the system 
before they are deleted. Once that time limit is reached, any suspended deposits will be deleted. It is 
important to be aware of this time limit and to avoid intentionally suspending deposits whenever possible. If 
you need more time to complete the deposit, contact your service organization.
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4 Reviewing Deposits 
The Review tab allows a deposit approver to review flagged deposits before they are submitted to a financial 
institution. If your organization is configured with Dual Control Deposit approval, the Review tab will be 
displayed for users with the appropriate privileges. For more information about configuring Deposit Dual 
Control, see the Portal User Guide. 

For more information on how to review a deposit, see the following sections: 

• Selecting a Deposit 
• Reviewing a Deposit 
• Completing a Review 

Selecting a Deposit 
The Select Deposit screen lists deposits with a status of In Review or Pending Approval. 

 

The grid on the Select Deposit screen displays the following information: 

• Client Deposit ID: The Client Deposit ID. 
• Deposit Status: Displays the status of the deposit. The grid will only show deposits with a Pending 

Approval or In Review status. 
• Submitted Date: The date/time when the deposit was submitted. 
• Submitted By: The username of the user that submitted the deposit. 
• Deposit Total: The total of the deposit. 
• Debit Items: The number of debit items within the deposit. 
• Account Name: The name on the account the deposit was submitted to. 
• Account Number: The account number the deposit was submitted to. 
• Submitted Channel: Will either be Mobile or Web Client. 
• Customer Name: The organization’s name. 
• Reviewed By: The username of the person who is reviewing the deposit.  

Note: This field will be left blank if the deposit has not been reviewed by a Customer Deposit 
Approver. If multiple Customer Deposit Approvers have reviewed the deposit, only the last 
Customer Deposit Approver’s name will be displayed. 

To display or hide any fields in the grid, left mouse-click on the right corner of a column header, select 
Columns, and select columns for display in the drop-down list. Columns in the grid can be rearranged and 
resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort Ascending or 
Sort Descending. 
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To select a deposit for review, do one of the following: 

 On the Select Deposit screen, click the Start Review button above the grid. 

The Review Deposit screen appears and the oldest available deposit will be displayed for review. 

OR 

 Select a deposit to review in the Summary grid by clicking the Review button next to the deposit you 
would like to review. 

The Review Deposit screen appears with the deposit you selected. For more information about reviewing a 
deposit, see Reviewing a Deposit in the next section. 

Note: The Review button will be disabled if the status of the deposit is In Review or if the reviewer scanned 
the deposit. 

Reviewing a Deposit 
On the Review Deposit screen, you can approve or reject a deposit, cancel a review, and view item details. 

Review Deposit Screen Overview 
The Review Deposit screen appears once a deposit is selected for review. It displays images and summary 
information for all items scanned for the deposit. 
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Item Details Panel 

The Item Details panel allows you to view the details of an item in a deposit that is being reviewed. Fields in 
the Items Details panel cannot be edited.  

If you would like to view another item in the deposit, click one of the following buttons in the Item Details 
panel: 

• Previous Item: Displays the previous item in the deposit. 
• Next Item: Displays the next item in the deposit. 

The Item Details panel can be collapsed, expanded, or resized. The application will automatically save any 
adjustments you make to the panel. To collapse or expand a panel, click on the arrow to the left of the panel 
name. 

Scanned Items Grid 

The Scanned Items grid allows you to view all items in the deposit that is being reviewed. To view a specific 
item, click on the row in the grid of the item for which you would like to view details.  

To display or hide any fields in the grid, left mouse-click on the right corner of a column header and select 
columns for display in the drop-down list. Columns in the Scanned Items grid can be rearranged and resized. 
You can also re-order items in the grid by clicking any column header and selecting Sort Ascending or Sort 
Descending. 

The Scanned Items grid can be collapsed, expanded, or resized. You can collapse the Item Details panel and 
edit all scanned items in the resized grid or you can collapse the Scanned Items grid and edit scanned items 
from the Item Details panel. To collapse or expand a panel, click on the arrow to the left of the panel name. 

Viewing and Zooming in on Item Images 
When you scan an item, the front image appears in the main part of the window. To view the front or back of 
an image, select the corresponding button at the top of the window.  

To zoom in on an image, click the Zoom button: . A menu appears giving you the option of zooming to 
view the full-size image, just the amount, or just the MICR line. 

 

The selected image or portion of the image is enlarged for better readability. 

To view other areas of the image, select any of the zoom options and grab the image with the mouse pointer. 
Once you have grabbed the image you can drag it to the area you would like to view in the image viewer 
window. 

Click the zoom standard button:  to return to the default image scan size. 

Approving a Deposit 
To approve a deposit, do the following: 

 On the Review Deposit screen, click Approve Deposit. 

A confirmation dialog box appears asking if you would like to approve the deposit. 
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 Click Yes, Approve Deposit to approve the deposit. 

After the deposit is approved, you can view details of the deposit on the confirmation page. See Completing a 
Review for more information. 

Rejecting a Deposit 
If an entire deposit is rejected, then all items in the deposit will also be rejected. To reject a deposit, do the 
following: 

 On the Review Deposit screen, click Reject Deposits. 

A confirmation dialog box appears asking if you would like to reject the deposit. 

 
 Click Yes, Reject Deposit to reject the deposit. 

After the deposit is rejected, you can view details of the rejected deposit on the confirmation page. See 
Completing a Review for more information. 

Canceling a Review 
Canceling a review will not cancel the deposit but will make the deposit available for another reviewer to 
review it.  

To cancel a review, do the following: 

 On the Review Deposits screen, click Exit. 

A dialog box appears asking if you would like to exit the review. 

 
 To exit the review, select one of the following options: 
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− Yes, and get next Deposit: Click this button if you would like to review the next oldest 
available deposit on the Review Deposit screen. 

Note: If there are no deposits pending approval, you will be taken to the Select Deposit 
screen. 

− Yes, Exit Review: Click this button to return to the Select Deposit screen. 

Completing a Review 
The Complete Deposit screen appears once you have accepted or rejected a deposit. It contains the following 
information about a deposit: 

• Deposit summary 
• Download options 
• Item details 

 

Once you have finished viewing the information on the Complete Deposit screen, you can either return to the 
queue and select a new deposit, get the next available deposit for review, or download the confirmation page.  

Deposit Summary 
The deposit summary includes details about the deposit and any deposit-level custom fields that have been 
configured. 

It includes the following information: 

• Customer: The customer name. Depending on how your service organization has configured it, this 
field may or may not be configured. 

• Account: The name of the account. 
• Account Number: The account number the deposit was submitted to. 
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• Deposit Total: The total amount of all check items in a deposit. 
• Items in the Deposit: The total number of items in a deposit including credit items. 
• Submitted Date: The date the deposit was submitted. 
• Submitted By: The name of the user who submitted the deposit. 
• Approved Date: The date the deposit was approved. 
• Approved By: The name of the reviewer who approved the deposit. 

Deposit Items 
The Deposit Items grid is located under the deposit summary and contains details about items in a deposit. It 
includes the following information: 

• Item: The client-side item ID that is associated with an item in a deposit. 
• Type: The item type. This can be DS or DR. 
• Aux On-Us: The aux on-us number found on the check. 
• EPC: The code assigned to an item if it has previously been processed electronically. 
• R/T: The route/transit number for the bank. 
• Bank On-Us: The account number and, in some cases, the check number. 
• Amount: The amount of the item. 

To display or hide any fields in the Deposit Items grid, left mouse-click on the right corner of a column header, 
select Columns, and select columns for display in the drop-down list. Columns in the grid can be rearranged 
and resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort Ascending 
or Sort Descending. 

Downloading the Deposit Summary 
The deposit confirmation page can be downloaded in CSV or PDF format. To download the deposit 
confirmation, click one of the following download formats from the Download drop-down list: 

• Download CSV: Includes the deposit and item details 
• Download Front PDF: Includes deposit and item details with front images 
• Download Front & Back PDF: Includes deposit and item details with front and back images 
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5 Setting User Preferences 
Web Client allows you to configure text that is printed on the back of paper items, change your password, and 
configure your email address for deposit confirmation. The Web Client configurable settings are all on the User 
Preferences tab. Configurable options can be changed at any time during the deposit process. 

 

You can complete the following configurations: 

 Changing Your Password 
 Configuring Text Printed on Items 
 Downloading the Scanner Driver 
 Configuring Email Notifications 

Changing Your Password 
You can change the password you use to log in to the application. If your service organization automatically 
logs you in through a link in another application (for example, from a business online banking system or a 
commercial portal), you cannot change your password here.  

Note: If your service organization has configured the system not to allow users to change their own 
passwords, this feature is not available. 

To change your password, do the following: 

 Log in to the application. 

 Click the User Preferences tab. 

The User Preferences screen appears. 

 In the Change Password panel, enter your current password into the Old Password field. 
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 In the New Password and Confirm New Password fields, enter your new password. You will use this 

password every time you log into the application. 

Your password must comply with certain restrictions as defined by your service organization. Contact 
your Service Representative for details. 

 Click Save All User Preferences Changes to save your password and any other changes that were 
made on the User Preferences screen. 

Your password has now been changed. It will remain valid for the period of time configured by your service 
organization, after which the application will prompt you to change it during login. 

Configuring Text Printed on Items 
If your check scanner is equipped with an inkjet printer, the scanner can print some information on the back of 
each item. You can configure the text that is printed on the back of items when they are scanned. The number 
of characters you can print on the back of the check may be limited by the physical size of the check.  

Your service organization may configure settings for Scanner Spray Text that will override any settings that 
you have configured. If you have special requirements for Scanner Spray Text, contact your service organiza-
tion.  

Note: This text is not considered an endorsement. 

The following table shows the total number of characters you may define based on what each scanner 
supports. Before you change this setting, determine how many characters you can print on the back of your 
items by locating your scanner in the table below. 

 
DCC Scanners Panini Scanners 

TS230 VX 1F, 50 

Total # of characters 45 70 

To change the text printed on items, do the following: 

 Click the User Preferences tab.  

The User Preferences screen appears. 

 In the Print Text Configuration panel, select the check boxes for the information you want to print on 
the back of items when they are scanned. 
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 You can print any of the following: 

− Deposit number: The identification number assigned to the current deposit by the Web Client 
Gateway. 

− Item number: The identification number assigned to the current item by the application. 
− Customer name: The name of the customer for which this application is configured (for 

example, your company name). 
− Current date:  The date and time the item was scanned. 
− The format is: DAY MON DD HH:MM:SS TMZ YYYY 
− User defined text: If you select this option, enter up to 10 characters to print on the item. You 

can use letters, numbers, and special characters. 

 Click Save All User Preferences Changes. 

The scanner will print the information you specified on the back of scanned items when you start your next 
deposit. 

Downloading the Scanner Driver 
Typically, you are automatically prompted to download and install the scanner drivers you need to use the 
application. However, if necessary, you can manually download and install the scanner drivers. You may 
need to do this if you experience problems with your scanner. Also, if you are switching from one scanner 
model to another, you must manually uninstall the existing scanner drivers and then install the correct drivers 
for your new scanner. See the following: 

 Removing Scanner Drivers 
 Installing Scanner Drivers 

Removing Scanner Drivers 
For Windows users: 

To remove the existing scanner drivers, do the following: 

 Log out of the application and close your browser. 

 Go to Start > Control Panel. Depending on the operating system you are using, click on one of the 
following: 

− Add or Remove Programs 
− Uninstall a Program 
− Programs and Features 

 Select NetCaptureScannerDrivers and click Remove. 
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Note: If you feel uncomfortable removing this application, or you cannot find the application, contact 
your IT personnel. 

Follow the prompts to remove the scanner drivers. Once you have completed the process, continue with the 
next section Installing Scanner Drivers to install new scanner drivers. 

For Mac users: 

To remove the existing scanner drivers, do the following: 

 Log out of the application and close your browser. 

 Click and open the Finder. 

  
 Click Command + Shift + G to find a folder. 

Enter /usr/local/lib in the search field and click Go. 

 
 In the folder, click and open the uninstall_scanner_service.tool file. 

 
 A warning appears asking if you want to uninstall Scanner Service. 

Enter the letter ‘y’ to continue. 

 
 Before Scanner Service can be uninstalled, you must enter your Mac password. 
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Enter your Mac password to continue. 

 
 A successful uninstallation message appears. 

 

Once you have completed the process, continue with the next section Installing Scanner Drivers to install new 
scanner drivers. 

Installing Scanner Drivers 
If you do not install the scanner driver after you first log in to the application, you can install it manually in the 
User Preferences tab. 

To download the scanner installer, click the Download the Scanner Installer button in the Scanner Driver 
panel and follow the scanner installation prompts. For more information on how to install a scanner, see 
Scanner Setup Process .  

 

Configuring Email Notifications 
Email Notifications are available to a submitter making deposits and an approver if Dual Control is enabled. 
When an email is configured for email notifications, that user will receive all the available notifications for their 
role.  

A Submitter can receive the following email notifications: 
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• Deposit Confirmation email 
• Rejected Deposit email 
• Rejected Item email 
• Adjustment Notice email 
• Deposit Pending Approval email 
• Deposit Reject email via Dual Control 

An Approver can receive the following email notifications: 

 Deposit Pending Approval email 

To receive email notifications or change the email address, do the following: 

 Click on the User Preferences tab. 

 In the Deposit Confirmation E-mail Address panel, enter your email address in the E-mail Address 
field. 

 Confirm that the email address is correct by re-entering it in the Confirm E-mail Address field.  

Once the email address has been saved, you will start receiving email notifications.  

Note: Email notifications can also be set when you start your deposit in the Deposit tab. Once you have 
entered your email address, it is stored by the system, and you will not be prompted to enter it again.  
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6 Reporting 
Web Client allows you to generate, view, and download deposit and item information from the Reporting tab.  

This chapter contains the following information: 

 Reports 
 Research 

Reports 
The Reports screen enables you to generate and download a summary of report data and item details. There 
are three reports that you can generate and download. 

 Report by Customer: Contains information about items deposited to a specific customer. 
 Report by Account: Contains information about items deposited to a specific account. 
 Report by Deposit: Contains information about deposits. 

This section contains the following content: 

 Report Criteria 
 Report Contents 
 Download Options 

Report Criteria 
To generate a report, you must choose the type of report you want to create and provide criteria that will 
determine the contents of the report. 

 

Follow the steps below to generate a report. 

 In the Reporting tab, click the Reports sub-tab. 

 Enter the following information in the Report Criteria panel: 

Field Description 

Report Type Select one of the following reports from the drop-down list: 
• By Customer 
• By Account 
• By Deposit 
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Field Description 

Account or 
Customer 

This field varies depending on the type of report you want to view. 
If you selected By Account in the Report Type field, select the account you 
want to view from the drop-down list.  
If you selected By Customer in the Report Type field, select the customer 
you want to view from the drop-down list. 
You can select All Accounts or All Customers, depending on the type of 
report. 
If you selected By Deposit in the Report Type field, this field will not be 
available. 

Show Select one of the following options: 
• Summary by Customer/Account: The results are summarized by the 

selected customer or account, depending on the type of report.  
• All Items: All items associated with the selected customer or account 

are displayed in the Item Details grid.  

Start Date The beginning date for which report data should be generated. Enter the 
date manually or click the calendar icon and select a date. 
The default entry is the current date. 

End Date The ending date for which report data should be generated. Enter the date 
manually or click the calendar icon and select a date. 
The default entry is the current date. 

Start Time The starting time for which report data should be generated. Select a start 
time from the drop-down list. 
Times can be set in 15-minute increments. The default start time is 00:00. 

End Time The ending time for which report data should be generated. Select an end 
time from the drop-down list. 
Times can be set in 15-minute increments. The default end time is 23:59. 

 Click Generate Report to view the report summary and item details. 

OR 

Click Clear Criteria to clear the search criteria you entered and start over. 

Once the report is generated, a summary of the report and report details appear. 

The Report Criteria panel can be collapsed in order to see more records in the Item Details grid. 

Report Contents 
Each report will include a report summary and item details. The Summary grid shows the report data 
summarized based on the type of report that was selected. The Item Details grid shows items associated with 
the generated report data. 

To display or hide any fields in the Summary grid and Item Details grid, left mouse-click on the right corner of 
a column header, select Columns, and select columns for display in the drop-down list. Columns in the grids 
can be rearranged and resized. Items in the grid can be re-ordered by clicking any column header and 
selecting Sort Ascending or Sort Descending. To collapse or expand a panel, click on the arrow to the left of 
the panel name. 
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Report Summary 

The details of the report summary will vary, depending on the type of report that is selected. 

If the Show Summary by Customer /Account button is selected in the search criteria, the Item Details grid will 
be collapsed and the results will be summarized by the customer or account that was selected. You can view 
items associated with a customer or account in the Summary grid by expanding the grid and clicking on a 
specific row. 

 

If the Show All Items button is selected in the search criteria panel, then the Summary grid will be collapsed 
and all items associated with the selected customer or account will be displayed in the Item Details grid. You 
can narrow the list of items by expanding the Summary panel and clicking on a specific row in the Item Details 
grid. 

 

The table below lists all of the data that can be seen in the report summary and which report they correspond 
with.  

Column Description 

Reports  
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Account Name The name on the account to which the deposit was 
submitted. 

X  X 

Account Number The account number the deposit was submitted to. 
If this field has been configured, it will be masked. 

X  X 

Account Status The status of the account. This can be Active or 
Inactive. 

X   
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Column Description 
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# of Deposits The number of deposits that were submitted to an 
account. 

X   

Total Deposited Amount The total amount of all deposits submitted for an 
account or customer. 

X X  

Debit Items The total number of debit items in a deposit for an 
account or customer? 

X X X 

# of In Process Deposits The total number of deposits that have an In 
Process status for an account or customer. 

X X  

In Process Deposits 
Amount 

The total amount of deposits that have an In 
Process status for an account or customer. 

X X  

In Process Debit Count The total number of debit items that have an In 
Process status for an account or customer. 

X X  

# of Completed Deposits The number of deposits that have been completed 
for an account or customer. 

X X  

Completed Deposits 
Amount 

The total amount of all deposits that have been 
completed for an account or customer. 

X X  

Completed Deposits 
Adjusted Amount 

The total amount of deposits after adjustments were 
made to items in the deposit. 

X X  

Completed Debit Count The total number of debit items for an account or 
customer. 

X X  

# of Rejected Deposits The total number of deposits that have been 
rejected for an account or customer. 

X X  

Rejected Deposits 
Amount 

The total amount of deposits that have been 
rejected for an account or customer. 

X X  

Rejected Debit Count The total number of rejected debit items for an 
account or customer. 

X X  

Customer  The name of the customer to which the deposit was 
submitted to. This field may or may not be 
configured by your service organization. 

X X X 

Server Deposit ID The global deposit ID assigned after submitting a 
deposit. 

  X 

Client Deposit ID The local deposit ID assigned when the deposit is 
created. 

  X 

Deposit Status The status of the deposit.    X 

Submitted Date The date the deposit was submitted on.   X 

Submitted By The name of the user who submitted the deposit.   X 
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Column Description 

Reports  
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Deposit Total The total amount of all deposits for an account or 
customer. 

  X 

Adjustment The amount of any adjustments made to an item.   X 

Deposit Channel The deposit application the deposit was submitted 
from. This can be Web Client or Mobile. 

  X 

Custom Fields Custom fields will vary, depending on what your 
service organization has configured. 

  X 

Item Details 

The Item Details grid shows the items that are associated with a report after it has been generated. It will 
show the same results for all of the reports. 

 

The table below lists all of the data that can be seen in the Item Details grid, which includes the following 
information: 

Column Description 

Server Item ID The global ID number assigned to an item. 

Client Item ID The local ID number assigned to an item. 

Item Type This can be debit or credit. 

Item Status The status of the item. This can be Processing, Ok, or Rejected. 

Item Amount The total amount for the item. 

Adjustment The amount of any adjustments made to an item. 

Aux On-Us The aux on-us number found on the check. 

EPC The code assigned to an item if it has previously been processed electronically. 

R/T The route/transit number for the bank. 

Bank On-Us The account number and, in some cases, the check number. 

Server Deposit ID The global deposit ID assigned after submitting a deposit. 

Client Deposit ID The local deposit ID assigned when the deposit is created. 
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Column Description 

Deposit Status The status of the deposit. This can be Completed or Rejected. 

Submitted Date The date the item was submitted on. 

Submitted By The name of the user who submitted the deposit. 

Deposit Total The total amount of all items in the deposit. 

Deposit Debit Items The total amount of all debit items in the deposit. 

Account Name The name on the account to which the deposit was submitted. 

Account Number The account number the deposit was submitted to. If this field has been 
configured, it will be masked. 

Account Status The status of the account. This can be Active or Inactive. 

Deposit Channel The deposit application the deposit was submitted from. This can be Web Client 
or Mobile. 

Customer The name of the customer to which the deposit was submitted to. This field may 
or may not be configured by your service organization. 

Payer The payer name. This field may or may not be configured by your service 
organization. 

Custom Fields Custom Fields will vary, depending on what your service organization has 
configured. 

Mobile Transaction ID The Mitek transaction ID. 

Viewing Item Images 

The Reports screen allows you to view an image associated with an item in a report. Do the following to view 
an item image: 

 In the Item Details grid, click on the Client Item ID of the item image you would like to view. An Image 
Review screen appears with the item image. 

 
 To view the front or back of the item image, click View Front/View Front. 

 To zoom in or out of the item image, click . 

The image or portion of the image is enlarged for better reading. 

 When you are finished viewing the item image, click Close. 
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Download Options 
The download options vary based on report type. The possible options could include: 

 Download CSV: Provides report data, including summary information and item details. This option 
is available for all reports. 

 Download PDF Front check images: Provides a PDF file containing summary information, item 
details, and check front images. PDF downloads are only available for By Deposit reports. 

 Download Front and Back check images: Provides a PDF file containing summary information and 
front and back check images. PDF downloads are only available for By Deposit reports. 

To download a report, click Download CSV or Download PDF, depending on the report you are downloading. 

Research 
The Research screen allows you to search for a specific item using more advanced search criteria. 

This section contains the following information: 

 Item Research 
 Research Details 
 Download Options 

Item Research 
To search for a specific item, you must provide criteria that will determine the contents of report. 

 

Follow the steps below to search for an item and generate a report: 

 In the Reporting tab, click the Research sub-tab. 

 Enter the following information in the Research Criteria panel: 

Field Descriptions 

Submitted From Date The beginning date for which report data should be generated. Enter 
the date manually or click the calendar icon and select a date. 
The default entry is the current date. 

Submitted To Date The ending date for which report data should be generated. Enter the 
date manually or click the calendar icon and select a date. 
The default entry is the current date. 
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Field Descriptions 

Submitted From Time The starting time for which report data should be generated. Select a 
start time from the drop-down list. 
Times can be set in 15-minute increments. 
The default start time is 00:00. 

Submitted To Time The ending time for which report data should be generated. Select a 
start time from the drop-down list. 
Times can be set in 15-minute increments. 
The default end time is 23:59. 

Submitted to Customer Select a customer from the drop-down list. 

Submitted to Account Select an account from the drop-down list. If nothing is selected, all 
accounts will be included in the search. 

Submitted By User Enter any part of the user’s user name that submitted the deposit. 

Item Amount From Enter the beginning item amount in a range of amounts included in the 
search. For example, to search for items with amounts between $100 
and $500, enter 100 here. 

Item Amount To Enter the ending item amount in a range of amounts included in the 
search. For example, to search for items with amounts between $100 
and $500, enter 500 here. 

Payer If your service organization is configured to enter the payer name when 
submitting checks, you can search by this name. 
Enter any part of the payer name you are looking for. 

Bank On-Us Enter the Bank On-Us number of the item. All items with Bank On-Us 
numbers that include the numbers you provide here will be returned in 
the search results. 

Route/Transit Number Enter the Route/Transit number of the item. All items with Route/Transit 
numbers that include the numbers you provide here will be returned in 
the search results. 

Aux On-Us Enter the Aux-On-Us number of the item. All items with Aux-On-Us 
numbers that include the numbers you provide here will be returned in 
the search results. 

Server Deposit ID From Enter the beginning server deposit ID number in a range of numbers 
included in the search.  

Server Deposit ID To Enter the ending server deposit ID number in a range of numbers 
included in the search.  

Server Item ID From Enter the beginning server item ID number in a range of numbers 
included in the search.  

Server Item ID To Enter the ending server item ID number in a range of numbers included 
in the search.  

Client Deposit ID From Enter the beginning client deposit ID number in a range of numbers 
included in the search.  

Client Deposit ID To Enter the ending client deposit ID number in a range of numbers 
included in the search.  
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Field Descriptions 

Client Item ID From Enter the beginning client item ID number in a range of numbers 
included in the search.  

Client Item ID To Enter the ending client item ID number in a range of numbers included 
in the search.  

 Click Generate Report to create a report. 

OR 

Click Clear Criteria to clear the search criteria that was entered and start over. 

Once the report is generated, the Research Details grid appears. 

Research Details 
A list of items based on the search criteria that was provided can be viewed in the Research Details grid. 

To display or hide any fields in the Research Details grid, left mouse-click on the right corner of a column 
header, select Columns, and select columns for display in the drop-down list. Columns in the grid can be 
rearranged and resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort 
Ascending or Sort Descending. 

 

The table below lists all of the data that can be seen in the Research Details grid, which includes the 
following: 

Column Description 

Server Item ID The global item ID number assigned to an item. 

Client Item ID The local item ID number assigned to an item. 

Item Type This can be debit or credit. 

Item Status The status of the item. This can be Processing, Ok, or Rejected. 

Item Amount The total amount for the item. 

Adjustment The amount of any adjustments made to an item. 

Aux On-Us The aux on-us number found on the check. 

EPC The code assigned to an item if it has previously been processed 
electronically. 

R/T The route/transit number for the bank. 

Bank On-Us The account number and, in some cases, the check number. 

Server Deposit ID The global deposit ID assigned after submitting a deposit. 
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Column Description 

Client Deposit ID The local deposit ID assigned when the deposit is created. 

Deposit Status The status of the deposit. This can be Completed or Rejected. 

Submitted Date The date the item was submitted on. 

Submitted By The name of the user who submitted the deposit. 

Deposit Total The total amount of all items in the deposit. 

Deposit Debit Items The total amount of all debit items in the deposit. 

Account Name The name on the account to which the deposit was submitted. 

Account Number The account number the deposit was submitted to. If this field has been 
configured, it will be masked. 

Account Status The status of the account. This can be Active or Inactive. 

Deposit Channel The deposit application the deposit was submitted from. This can be Web 
Client or Mobile. 

Customer The name of the customer to which the deposit was submitted to. This field 
may or may not be configured by your service organization. 

Payer The payers name. 

Custom Fields Custom Fields will vary, depending on what your service organization has 
configured. 

Mobile Transaction ID The Mitek transaction ID. 

The Research Criteria panel can be collapsed in order to see more records in the Research Details grid. 

Viewing Item Images 

The Research screen allows you to view an image associated with an item. Do the following to view an item 
image: 

 In the Research Details grid, click on the Client Item ID of the item image you would like to view. 

An Image Review screen appears with the item image. 

 
 To view the front or back of the item image, click View Back/View Front. 

 To zoom in or out of the item image, click . 
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The image or portion of the image is enlarged for better reading. 

 When you are finished viewing the item image, click Close. 

Download Options 
The download options for researched reports include: 

 Download CSV: Provides report data, including summary information and item details.  
 Download PDF Front check images: Provides a PDF file containing summary information, item 

details, and check front images.  
 Download Front and Back check images: Provides a PDF file containing summary information and 

front and back check images.  

To download a report, click Download CSV or Download PDF.
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7 User Administration 
The Admin tab allows an organization to administer their users within their home organization. An admin can 
create new users, assign user roles, reset user passwords, and clone existing users. Depending on the 
privileges your service provider has configured for your organization, the Admin tab may not be accessible. 

Note: The Admin tab does not support administration of users across multiple orgs. 

This chapter contains the following information: 

• Searching for a User 
• Creating a User 

 

• Editing a User 
• Cloning a User  

Searching for a User 
You can search for a user by entering the user name, email address, or user status in the Search Users text 
box and the grid will automatically filter a list of users as you type.  

 

You will only see users that you have access to from your home organization. Users from other organizations 
will not be displayed on Admin tab even though you might have access to them.  

 

The list of users contains the following information: 

Column Description 

User Name The user name of the user. 

First Name The first name of the user. 

Last Name The last name of the user. 

Status The status of the user. The status can be Active or Inactive. 
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Column Description 

Email for Mobile 
Alerts 

The email address of the user for email notifications about deposits submitted from 
the Mobile application. 

Deposit Review 
Limit 

Deposit limit threshold for the user that will require a secondary approval (Dual 
Control) before being submitted to the financial institution. See Reviewing Deposits 
for more information. 
Note: This field will only be displayed if the Dual Control rule is active. 

Clone User Allows you to create a new user by cloning an existing user. See Cloning a User for 
more information. 

Note: To display or hide any fields in the grid, left mouse-click on the right corner of a column header, select 
Columns, and select columns for display in the drop-down list. Columns in the grid can be rearranged and 
resized. Items in the grid can be re-ordered by clicking any column header and selecting Sort Ascending or 
Sort Descending. 

Creating a User 
To create a user, do the following: 

 On the Admin screen, click on the New button. 

 The Create User screen appears with the Profile tab selected.  

 
Enter the following information into the fields on the Profile tab: 

Field Description 

User Name The user name that will be used to login to Web Client. 
Note: Once a user’s user name is created and saved, it cannot be changed. 

First Name The first name of the user. 

Last Name The last name of the user. 
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Field Description 

Password The default password for the user. 
Note: This field is only displayed if applicable for your organization. 

Confirm Password The confirmation of the default password previously entered. 
Note: This field is only displayed if applicable for your organization. 

Email for Mobile 
Alerts 

The email address that will be used for mobile deposit alerts.. 
Note: This field is only displayed if your organization is configured for Mobile 
deposits. 

Deposit Review 
Limit 

The deposit limit threshold for the user that will require a secondary 
approval (Dual Control) before being submitted to the financial institution.  
Note: This field will only be displayed if the Dual Control rule is active. 

Note: Required fields are marked with an asterisk. 

 Click Next to create the user’s profile and advance to the Assign Roles tab.  

 On the Assign Roles tab, select the check box next to the role that you want to assign to the user in 
the Assigned Roles section.  

Note: The list of roles will not exceed the admin’s privileges.  

 
 The information displayed in the Account Access column depends on the displayed role. Some roles 

can be assigned at the account level and other roles can only be assigned at the customer level.  

The account access levels are: 

− Customer level: The user will have access to all accounts within their organization. If a new 
account is added to the organization at any time, users will automatically get access to that 
account.  All Accounts will be displayed in the Account Access column for each customer 
level role. 

− Account level: The user will have access to the specific account selected. If a new account is 
added to the organization at any time, user roles need to be updated to access that account.  
All account levels roles will have a drop-down list of available accounts to assign to the user 
role. 
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 Click Done when you finish assigning roles to the user. 

The roles are now assigned to the new user.  

Editing a User 
The profile and assigned roles can be updated when editing a user. On the user’s profile, all information 
except for the user name can be edited. Assigned roles and accounts can be added or removed. 

To edit a user, do the following: 

 On the Admin screen, click on the user name in the grid that you want to edit. 

 The Update User screen appears.  
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You can edit the following fields on the Update User screen: 

Field Description 

First Name The first name of the user. 

Last Name The last name of the user. 

Password The password for the user. 
Note: This field is only displayed if applicable for your organization. 

Confirm Password The password a second time to confirm it is correct. 
Note: This field is only displayed if applicable for your organization. 

Status The status of the user. The status can be one of the following: 
• Active:  The user is able to log in to the application. 
• Inactive:  The user is deactivated and cannot log in to the application. 

You can set any user into Inactive status if needed. 
Note: If a user is locked out of the application due to failed attempts to 
login or due to inactivity, the user status will be displayed as Inactive. 
You can restore the user’s status to Active at any time. 

• Deleted: The user will no longer be displayed in the list of users but will 
still be visible in the reports associated with the deposits made by this 
user.  

Email for Mobile 
Alerts 

The email address for the user to receive mobile alerts regarding deposits 
made from the Mobile application. 
Note: This field is only displayed if your organization is configured for Mobile 
deposits. 

Deposit Review 
Limit 

The deposit review limit amount for the user.  
Note: This field will only be displayed if the Dual Control rule is active. 

 Click Next to save the changes and advance to the Assign Roles screen.  

Changes to the user’s profile will be saved.  

 On the Assign Roles screen, you can do the following: 

− Delete a role: Uncheck the check box next to the role in the Role column to delete a role. 
− Add a role: Select the check box next to the role in the Role column to add a role. 
− Remove an account from a user’s access: Select the required role in the Role column and 

uncheck the check box next to the account in the Accounts section to remove an account 
from the user’s access. 

− Add a new account to a user’s access: Select the required role in the Role column and select 
the account in the Accounts section that you want to add to the user access.  

 Click Done to save the changes. 

Changes to the user’s assigned roles and accounts will be saved. 

Cloning a User 
A new user can be created by cloning an existing user from the Admin tab.  

To clone a user, do the following: 
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 In the Clone User column on the Admin screen, click on the Clone icon  next to the user to be 
cloned. The Cloning User screen appears with the Profile tab selected.  

 
Enter the fields on the Profile tab. See Creating a User for more information about the fields on the 
screen. 

Note: If your organization has been configured for Dual Control, the Deposit Review limit field is the 
only field that will be populated with the amount from the cloned user. All other profile information is 
unique to the new user. 

 Click Next to create the user profile and advance to the Assign Roles tab. The Assigned Roles tab will 
be prepopulated with the roles from the cloned user.  

 
Make necessary changes to the displayed roles or save them as is by clicking the Done button. 

Note: Roles are not saved for the new user until you click Done. 

The new user has now been created. 
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8 Troubleshooting 
This section contains information to help you troubleshoot problems you may encounter. It contains the 
following: 

 Login and Authentication Errors 
 Scanner Errors 
 Item Processing Issues 
 Deposit Issues 
 Reporting Issues 
 General Issues 

 Restoring Default Application Configurations 

Note: Possible issues you may encounter may be caused by your PC not meeting software requirements, 
which can cause slow behavior. To view a complete list of requirements, see System Requirements. 

Login and Authentication Errors 
Some possible login and authentication issues and resolutions are listed below. 

Issue/Error Description Resolution 

You are unable to open the 
application. You receive the 
following error: 
The browser cannot display the 
web page. 

The Web Client connection failed 
because the Web Client Gateway 
is down. 

Contact your Service 
Representative. 

You receive an error configured 
by your service organization to 
inform you of a planned or 
unplanned network outage. 

The Web Client connection failed 
because the Capture Gateway 
component of the NetCapture 
Platform is down. 

Follow the instructions provided in 
the message, or contact your 
Service Representative. 

You are unable to log in to the 
application. 

User names and passwords are 
case sensitive, and passwords 
must comply with certain 
restrictions configured by your 
service organization. 

Ensure you enter the correct user 
name and password as provided 
by your Service Representative. 
Contact your Service 
Representative for details about 
your specific password 
requirements. 
If you continue to be denied 
access to the application, contact 
your Service Representative. 

You cannot log in to the 
application at the current time. 

The application may be 
configured to restrict access at 
certain times. 

Contact your Service 
Representative for information 
about the days and times during 
which the application is available 
to you. 
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Issue/Error Description Resolution 

The application will not allow you 
to set the password you desire. 
You may receive the following 
errors: 
• The new password you 

provided is not valid. 
• The password you provided 

does not meet the length 
requirements configured by 
your service organization. 

• The password you provided 
does not contain any numeric 
characters. 

• Your password cannot be the 
same as your user name. 

• The password you provided 
does not contain any alpha 
characters. 

• The new password cannot be 
the same as the old 
password. 

Password requirements are 
configured by your service 
organization. For example, your 
service organization may require 
that your password be at least six 
characters in length and use a 
numeric value, and may use a list 
of excluded words that may not 
be used as passwords. In 
addition, you may not be allowed 
to use a password that you have 
used previously. 

Contact your Service 
Representative for details about 
your specific password 
requirements. 
In addition to your service 
organization’s configurable 
requirements, your password may 
not be the same as your user 
name. 

You entered an invalid user name 
or password. 

User names and passwords are 
case sensitive, and passwords 
must comply with certain 
restrictions configured by your 
service organization. 

Ensure you enter both your 
correct user name and password 
as provided by your Service 
Representative. Either your user 
name or your password was 
incorrect, so re-enter both. 
Contact your Service 
Representative for details about 
your specific password 
requirements. 

Your password has expired. You must change your password 
before you can log into the 
application. 

Click OK to change your 
password now, and the Change 
Password window appears. See 
Changing Your Password for 
instructions. 

The values you entered for your 
new password do not match. 

 Re-enter your password in the 
New Password and Confirm 
Password fields, ensuring they 
are the same. 

You entered invalid password 
information. 

 Re-enter the password 
information. If the problem 
persists, contact your Service 
Representative. 

The application cannot connect to 
the server because the certificate 
on the server is not trusted. 

 Contact your Service 
Representative. 

You logged in, but the application 
is unresponsive. 

The network lost connection while 
downloading the Web Client 
applet. 

Close and restart the browser and 
log in again. 
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Scanner Errors 
The following are some possible scanner errors that may occur when scanning items for a deposit. 

Issue/Error Description Resolution 

I need to switch to a new model of 
scanner. 

If you have been using one 
scanner model but need to switch 
to a new one, you must manually 
remove the scanner drivers and 
then re-install the correct drivers 
for your new scanner. 

Follow the directions in 
Downloading the Scanner Driver 
to remove the existing drivers and 
re-install the correct ones. 

The application says that my 
scanner is not plugged in or is 
turned off. 

The scanner will not function, but 
it is plugged into the computer 
and the power is on. 

First, try restarting the browser. If 
that does not work, reboot the 
computer. 
If the scanner is still not 
responding, it is possible that you 
installed the wrong scanner 
driver. Follow the directions in 
Downloading the Scanner Driver 
to remove the existing drivers and 
re-install the correct ones. 

The scanner is not functioning 
properly. 

Reason 1: This message may 
indicate that the ink cartridge in 
your scanner is not seeded 
properly or is out of ink and you 
have the Print Text Options 
enabled. 

Resolution 1: If you have an inkjet 
scanner, check to ensure that the 
ink cartridge in the scanner is 
seeded correctly and that it has 
ink. Also, make sure that Print 
Text Options is enabled. 
If you have a non-inkjet scanner, 
make sure Print Text Options is 
disabled. See Configuring Text 
Printed on Items. 

Reason 2: This message may 
indicate that there are items stuck 
in the scanner. 

Resolution 2: Check to see if any 
items are stuck in the scanner. If 
so, remove them, reset the 
scanner, and try again. If the 
problem persists, close the 
application, restart the scanner 
manually by turning the power off 
and then on, and then restart the 
application. 
If the problem persists, contact 
your Service Representative. 

Reason 3: This message may 
indicate that your scanner’s inkjet 
cartridge needs to be replaced. 

Resolution 3: Insert a new inkjet 
cartridge into the scanner. 

Reason 4: This message may 
indicate that you have print text 
options configured but your 
scanner does not have an inkjet 
cartridge inserted. 

Resolution 4: Either insert the 
inkjet cartridge or remove the 
configured print text settings in 
User Preferences.  
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Issue/Error Description Resolution 

The scanner cannot be detected. This error appears if the 
application cannot form a 
connection with the scanner when 
you try to scan an item. 

Check to ensure the scanner is 
connected to the computer, is on 
and all the cables are attached 
securely. When all are in proper 
order, click OK, then try to scan 
the item again. 

My laptop computer fails to detect 
the scanner. 

This error occasionally appears if 
the scanner is plugged into the 
USB port on a laptop computer’s 
docking station. 

Be sure that the scanner is 
plugged into the USB port on the 
computer, and not into the USB 
port on a laptop docking station. 
Docking stations can cause 
irregular behavior with the 
scanner operation and should be 
avoided. 

There is a problem with the 
scanner’s USB connection. 

 Check to ensure the scanner is 
connected to the computer, is on, 
and the USB cable is attached 
securely. When all is in order, try 
scanning the item again. 

It takes a long time to initialize the 
scanner each time I want to begin 
scanning. 

Reason 1: This error most often 
occurs when using the DCC 
TS230 scanner. These scanners 
may take 10-15 seconds to 
initialize when they are first 
powered up and the application is 
launched. 

Resolution 1: If you are using the 
DCC TS230 scanner, and 
anticipate multiple scanning 
sessions, you may close the 
application after you have 
completed the first session, but 
you may wish to leave the 
scanner powered on (the status 
LED should remain green). 
Subsequent scanning sessions 
will initialize much more quickly. 

Reason 2: This error can occur if 
your computer is not running the 
recommended specifications, 
which will cause the program and 
the scanner to run slower. 

Resolution 2: Check to ensure 
your computer meets the 
minimum system requirements. 
If it does not, contact your system 
administrator or local IT resource 
to meet the required 
specifications. 
See System Requirements for the 
list of required specifications your 
computer will need in order to run 
Web Client and the scanner. 

I scanned a check, but the 
application issues a scanner is 
empty message. 

There are no items to scan in the 
input slot of the scanner. 

Make sure there are checks in the 
input slot of the scanner before 
scanning. 

The text string passed to the 
scanner is too long. The scanner 
was unable to print the text on the 
item. 

This string is the text to be printed 
on the back of the item for 
research purposes. If you receive 
this error, the configured text is 
too long for the scanner to 
handle. 

See Configuring Text Printed on 
Items to change the text string. 
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Issue/Error Description Resolution 

• The scanner was unable to 
read the image. 

• The scanner was unable to 
save the image. 

• The scanner was unable to 
save complete information for 
the item. 

• The scanner was unable to 
process the image. 

 Rescan the item. If the problem 
persists, contact your Service 
Representative. 

Double feed detected. Two items have been scanned at 
the same time. 

Reject the items and reprocess 
them. 

An item appears to be stuck in the 
scanner. 

 Remove any stuck items and try 
to reprocess them. You may need 
to clean the document track of the 
scanner. 

The scanner appears to be 
jammed. 

 Remove any jammed items and 
try to reprocess them. You may 
need to clean the document track 
of the scanner. See your scanner 
quick reference guide for more 
information on scanner cleaning 
and maintenance. 

The scanner has timed out.  Try restarting the scanner 
manually. Turn the scanner’s 
power off and shut down the 
application. To restart, first turn 
the scanner’s power back on, and 
then launch the Web Client. 
If the problem persists, contact 
your Service Representative. 

Can I increase the scanner 
performance? 

 If you are using the DCC TS230 
scanner and your PC has a USB 
2 port, modifying the Image Wait 
time in the BUICSCAN.INI file to a 
value of 500 milliseconds could 
result in an increase in 
performance.  
Note: If you are unfamiliar with 
working with .INI files, we 
recommend that you contact your 
system administrator or local IT 
resource to make this change. 

Scanner stops speaking to the 
client. 

The power to the scanner has 
been turned off. 

Clear (deselect) the Allow the 
computer to turn off this device to 
save power check box on the 
Power Management tab in your 
computer’s Properties window. 
See the Quick Start Guide for 
your scanner. 
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Item Processing Issues 
The following are some possible issues that may occur when scanning and editing items for a deposit. 

Issue/Error Description Resolution 

The application tells me my 
scanner is not on or plugged in, 
but it is. 

The scanner driver is not installed 
or an incorrect scanner is 
installed. 

Log out of the application and 
close Internet Explorer. 
Open the Windows Control 
Panels > Add or Remove 
Programs. 
Remove 
NetCaptureScannerDriversInstall. 
Follow the direction to uninstall 
the drivers. 
From the installation directory 
(typically, this is C:\Documents 
and 
Settings\<USERNAME>\Local 
Settings\Application Data), delete 
the NetDeposit folder. 
Note: If you feel uncomfortable 
deleting this folder, or you cannot 
find the folder, contact your IT 
personnel. 
Follow the directions in First Time 
Login Process to install the 
correct scanner driver. 

Items scanned do not appear in 
the grid. 

Your network or Internet 
connection was interrupted or 
lost. 

Any item that you scanned prior 
to losing the Internet connection 
should be listed in the grid. Items 
scanned after losing the 
connection will not be recorded 
by the server, and therefore not 
listed in the grid. These items 
should be rescanned. 
Check your network connection or 
contact your system administrator 
to re-establish your Internet con-
nection. 
Compare the paper items against 
the items in the grid to ensure you 
are scanning the proper items. 
Place the item(s) in the scanner 
slot and click Scan. 
The rescanned items will be listed 
in the grid. 

There is a problem during 
scanning, and you need to stop 
the scanning process. 

 Remove the remaining items from 
the input slot of the scanner. The 
scanner will finish scanning the 
current item, then stop. 
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Issue/Error Description Resolution 

An item was scanned upside-
down or backward, or two or more 
items are scanned 
simultaneously. 

See the figure below. 
 

Remove any jammed items from 
the scanner. 
Place the items back into the 
scanner with the front of the items 
facing the status lights of the 
scanner and the MICR line at the 
bottom of the scanner and rescan 
the items. 

 

Only a partial image was 
scanned, or the image is cut off. 

See the figure below. Remove any jammed items from 
the scanner. 
Place the items back into the 
scanner with the front of the items 
facing the status lights of the 
scanner and the MICR line at the 
bottom of the scanner and rescan 
the items. 

 

The scanned image is folded or 
crooked. 

See the figures below. Remove any jammed items from 
the scanner. 

Place the item back into the 
scanner to be rescanned and 
processed in the deposit. 
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Issue/Error Description Resolution 

 

 

The scanned image has black 
streaks or a black bar across the 
top. 

See the figure below. Rescan the item. If the image is 
still bad, then the scanner may be 
over-exposed to light. 
Reject the item by clicking the 
delete icon. 
Move the scanner so it is not 
directly under bright light, or 
shield it from an overhead light 
source. You may also try 
removing and then replacing the 
scanner cover to ensure it is 
tightly in place. 
Try reprocessing the item. 
If you are using a Digital Check 
scanner, try calibrating the image. 
If the black streaks persist, they 
may not pose a problem for 
downstream processing of the 
item. 
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Issue/Error Description Resolution 

 

A scanner is experiencing 
mechanical errors, performance 
problems, or other malfunction; or 
the scanner is no longer 
producing clear, readable stamps 
on scanned items. 

The ink rollers, stamp pads, and 
inkjet cartridge need replacing on 
a periodic basis. 

Perform the preventative 
maintenance procedures outlined 
in the quick reference guides for 
the scanners. 

After the check was scanned, 
either the front or back original 
image is missing. 

 Reject the item and reprocess it in 
order to capture the original 
images. 

An item is automatically rejected.  Locate the item and reprocess it. 
If it continues to be rejected, you 
can remove the item from the 
deposit and deposit it manually at 
your bank. 

Deposit Issues 
The following are some possible issues that may occur when making deposits. 

Issue/Error Description Resolution 

The account I need is not in the 
list. 

 Contact your Service 
Representative to activate the 
correct account. 

The route/transit of the deposit 
slip does not match the RT 
number of the customer account. 

The route/transit number on the 
deposit slip you scan for a deposit 
must match the route/transit 
number that is configured in the 
system for the depository 
account. 

Edit the route/transit number to 
the correct value, or scan a 
different deposit slip with the 
correct route/ transit number. 

The account number of the 
deposit slip does not match the 
deposit account number. 

The account number on the 
deposit slip you scan for a deposit 
must match the account number 
of the depository account you 
have selected. 

Edit the account number to the 
correct value, or scan a different 
deposit slip with the correct 
account number. 
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Issue/Error Description Resolution 

The control balance you entered 
is invalid. 

The control balance must be 
greater than 0, and must not 
exceed $99,999,999.99. 

Re-enter the control balance, 
then continue with the deposit. 

A control balance is required for 
the customer account you 
selected. 

The control balance must be 
greater than 0, and must not 
exceed $99,999,999.99. 

Enter a control balance. 

The item amount you entered 
cannot be accepted. 

The amount must be greater than 
$0.00 and cannot exceed 
$99,999,999.99. 

Edit the amount as appropriate 
and accept the item again. 

The amount you entered is 
formatted incorrectly. 

The amount must only contain 
numbers and include 2 decimal 
places. 

Edit the amount as appropriate 
and accept the item again. 

The item amount is not present.  Enter an item amount and accept 
the item again. 

The item total has reached the 
maximum deposit amount. 

The item you just added to the 
deposit has put the deposit over 
the maximum amount allowed for 
a deposit. 

Reject the item and add it to a 
new deposit. 

The numeric amount on the check 
is different than the printed 
amount on the check. 

 Regulation UCC 3-114 states: "If 
an instrument contains 
contradictory terms, typewritten 
terms prevail over printed terms, 
handwritten terms prevail over 
both, and words prevail over 
numbers." 

The route and transit number is 
not present. 
The route and transit number is 
not 9 digits. 
The route and transit number con-
tains non-numeric characters. 
The route and transit number for 
this item appears to be invalid. 

 Enter the eight- or nine-digit, 
numeric route and transit number 
as found on the image before 
accepting the item. 
Deposit slips can have eight-digit 
route and transit numbers in the 
format of 4-4 (4 hyphen 4). 

The route and transit number for 
this item cannot be accepted. 
Your service organization has 
configured it as invalid. 

 Reject the item. It will not be 
included in the deposit. You may 
process the item manually by 
taking it to a bank branch for 
deposit. 

The bank on-us number is not 
present. 
The bank on-us number contains 
non-MICR characters. 
The bank on-us number is invalid. 

The bank on-us number can 
contain numbers, forward slashes 
(/), capital O, dashes, and 
spaces. 

Enter the bank on-us number 
exactly as it appears on the 
image, using a forward slash (/) to 
replace the on-us symbol, which 
looks like this: 

 

The aux on-us number contains 
non-numeric or disallowed 
characters. 

The aux on-us number can 
contain numeric characters, 
spaces, or dashes. 

Enter the aux on-us number 
exactly as it appears on the 
image. 
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Issue/Error Description Resolution 

The EPC field can only contain 
one digit. 

 Enter the EPC number as it 
appears on the item. 

Items in this deposit have invalid 
data. 

 Correct the fields that have errors 
(these are outlined in red and 
appear in red text) before 
completing the deposit. 

The control balance reflects a 
different amount than the deposit 
amount. 

This may happen when a control 
balance was entered and then an 
item was removed from the 
deposit. If a control balance or 
deposit slip is required, then the 
deposit is required to balance. 

If the deposit is still active, you 
may change the amounts of items 
as needed to balance the deposit. 
See Balancing the Deposit for 
instructions. If you have already 
submitted the deposit, contact 
your service organization to have 
the problem corrected. 

The total amount of the deposit 
cannot be accepted. 

The amount cannot exceed 
$99,999,999.99, or some other 
amount as configured by your 
service organization. 

To complete the deposit, reduce 
the total amount of the deposit by 
removing some items. 

The deposit has reached the 
maximum number of items it can 
contain. 

You cannot add any more items 
to the deposit. 

To deposit more items, submit the 
current deposit and start a new 
one. 

While processing a deposit, the 
workstation crashed or the 
Internet connectivity was lost. 

The application will automatically 
suspend and save the deposit 
that is currently in progress. 

When the workstation comes 
back up, log into the application 
and the suspended deposit will be 
resumed. 
If the suspended deposit is not 
resumed, contact your Service 
Representative. 
Note: Ensure all the items you 
scanned appear in the item grid, if 
not, rescan those items to add 
them to the deposit. 

You cannot complete the deposit 
because the scanner is still 
scanning items. 

 Wait until scanning is complete, 
or remove the remaining items 
from the input slot of the scanner, 
then try again to complete the 
deposit. 

A deposit was suspended, but it 
was not resumed after logging in 
to the application. There are two 
possible reasons why this may 
occur. 

Reason 1: A System Manager 
user may have inactivated the 
customer or account. The deposit 
is not presented to the application 
user for completion since the 
customer or account has been 
inactivated. 

Resolution 1: The application 
user should log out and notify 
their system administrator of the 
problem. In System Manager, the 
administrator must re-enable the 
customer or account for a long 
enough period of time so that the 
application user is able to 
complete the deposit. Once the 
deposit has been submitted, the 
administrator can once again 
inactivate the customer or 
account in System Manager. 
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Issue/Error Description Resolution 
Resolution 2: The administrator 
can delete the deposit in Web 
Manager and have the deposit 
reprocessed using a different 
customer or account. 

Reason 2: The Web Client 
administrator deleted the deposit 
or the system automatically 
deleted the deposit because it sat 
unfinished for longer than the 
allowed time. 

Resolution 2: Rescan and 
resubmit the entire deposit. 

Funds were deposited into a 
wrong account. 

 Abort the deposit and re-scan it 
into the correct depository 
account. After it has posted to the 
incorrect account, transfer the 
funds into the correct account by 
using your bank’s transfer options 
(Internet, ATM, customer service, 
etc.). 
The deposit can be corrected by 
contacting your local bank branch 
or bank customer service. 

Problems were encountered 
when processing the image. If 
desired, try scanning the item 
again. 

 Rescan the item. 

Reporting Issues 
Following are some possible issues you may encounter when using the reporting application: 

Issue/Error Description Resolution 

A login window appears in the 
Reporting tab in place of the 
organization list. Instead of the 
organization list, fields to enter 
your user name and password 
appear on the screen. 

You cannot generate a report 
because you cannot select an 
organization. This problem occurs 
because the browser security 
settings are too high. 

Set your Internet Explorer security 
settings to Medium or lower by 
doing the following: 
Choose Tools > Internet 
Options... 
Click the Security tab. 
Slide the slider bar down until 
Medium or lower appears as the 
security level. 
Click OK. 

General Issues 
The following are some general issues you may encounter with the Web Client application: 
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Issue/Error Description Resolution 

The application logs you out 
automatically. You may receive 
the following error: 
Your session has timed out. The 
application will close. 

If the application remains idle—in 
other words, if you do not press 
any keyboard keys or move your 
mouse— for a period of time as 
configured by your service 
organization, the application will 
automatically log you out and 
request that you log in again. 
In addition, you are only allowed 
to remain logged in for the period 
of time configured by your service 
organization. The default is 60 
minutes. If your login session 
exceeds the configured time 
period, the application will log you 
out automatically. 

You must log in again before you 
can continue working in the 
application. To avoid being 
logged out automatically, 
continue to use the system 
without significant lapses in 
activity. 

An unexpected error has 
occurred. 

 Try exiting and restarting the 
application. If the problem 
persists, contact your Service 
Representative. 

The application appears to 
freeze. 

If the application appears to 
freeze or hang, the server may 
have temporarily stopped 
responding. 

Contact your Service 
Representative and notify them of 
the problem. 

You receive deposit rejection or 
adjustment notifications by email. 

For example: 
------ 
Subject: Rejected Deposit 
John Doe 
Deposit number 3 for $50.00 was 
rejected due to the following 
reason: 
Suspected duplicate deposit 
If you have any questions or 
concerns, please contact 800-
444-5555. 
Thank you, 
First National Bank 
------ 
These adjustment notifications 
are sent when changes are made 
to deposits or items. The person 
to whom these notifications are 
sent is configured in System 
Manager. 

If you are receiving these 
notifications in error, contact your 
Service Representative to have 
the messages redirected. 

You log into the site and a black 
screen appears where Web Client 
should be. 

Web Client software only works 
within Internet Explorer, Mozilla 
Firefox, and Google Chrome. 
Accessing it through other web 
browsers will not work. 

Open Internet Explorer, Mozilla 
Firefox, or Google Chrome and 
access site. 
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Issue/Error Description Resolution 

The local environment cannot be 
initialized. 

A process accessing IE is already 
running in the background or 
another IE window. 

Reboot your PC and log in again. 
If that does not work, delete the 
NetDeposit folder from your 
directory and log back into Web 
Client. 

The application cannot be 
initiated. 

Older versions of Web Client, 
previous to Windows 7/Vista, do 
not have the command to get the 
MAC address from the PC. 

Call support to update your local 
database with a valid MAC 
address. 

Failed to receive email 
notifications. 

Your email address was not 
added, or an invalid email 
address was added during your 
first deposit. 

Select the User Preferences tab 
along the top right of the scanning 
client and enter/update email and 
click submit at the bottom of the 
page. See Configuring Email 
Notifications. 

Restoring Default Application Configurations 
If you need to reset the application and restore it to the default configurations, you may do so by removing the 
application cookies. 

This section contains the following information about restoring default configurations: 

 Internet Explorer Configurations 
 Firefox Configurations 
 Chrome Configurations 
 Safari Configurations 

Internet Explorer Configurations 
If you are using Internet Explorer, you will need to remove cookies by deleting the files manually from your 
computer. Do the following: 

 In Internet Explorer, click on the Tools icon and select Internet Options. 

 In the General tab, click Delete in the Browsing History section to delete the browsing history. 
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 A Delete Browsing History dialog box appears. 

 
Ensure the Cookies and website data check box is selected. 
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 Click Delete. 

 In the Internet Options box, click OK. 

 If you are currently using Web Client, log out and close the application. 

 Go to the following location in your file directory: 

− Windows 7: C:\Users\<domain name>\AppData\Local\Microsoft\Windows\Temporary Internet 
Files 

− Windows 8: C:\Users\<domain name>\AppData\Local\Microsoft\Windows\iNetCache 

Note: If your system hides directories, you may need to manually enter the file location at the top of 
the file directory window. 

 Delete all of the files in that directory. 

 

The application should now be reset and the defaults restored. 

Firefox Configurations 
If you are using Firefox, do the following to remove the application cookies: 

 In Firefox, click Ctrl + Shift + Delete. 

The Clear Recent History dialog box appears. 

 
 Click on the arrow next to Details. 

 Ensure Cookies is checked in the list. 



 

© Finastra  |  Fusion NetCapture  |  Web Client User Guide 88 

 
 Click the Clear Now button. 

The application should now be reset and the defaults should be restored. 

Chrome Configurations 
If you are using Chrome, do the following to remove the application cookies: 

 In Chrome, click Ctrl + Shift + Delete. 

A Clear browsing data window appears. 

 
 Select only Cookies and other site and plugin data. 

 Click Clear browsing data. 

The application should now be reset and the defaults restored. 

Safari Configurations 
If you are using Safari on Mac, see the following to restore default configurations: 

• Clearing Safari History 
• Clearing Safari Cache 
• Removing Safari Extensions 
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• Switching off Plug-ins 

Clearing Safari History 
 Launch Safari and click on the Safari menu. 

 Select Clear History. 

 Click the drop-down menu next to Clear and select the amount of time (the last hour, today, today and 
yesterday, or all history) you would like to clear.  

Note: If you want to completely reset Safari, choose all history. 

 Click Clear History. 

 

Clearing Safari Cache 
 Launch Safari and click on the Safari menu. 

 Select Preferences. 

 Click on the Advanced tab. 

 Ensure the Show Develop menu in menu bar check box is selected. 

 Click on the Develop menu and select Empty caches. 
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Removing Safari Extensions 
 Launch Safari and click on the Safari menu. 

 Select Preferences. 

 Click on the Extensions tab. 

 A window appears with a list of installed extensions. Click on each extension in the list and click 
Uninstall to completely reset Safari. 

Switching off Plug-ins 
 Launch Safari and click on the Safari menu. 

 Select Preferences. 

 Click on the Security tab. 

 Ensure the Allow Plug-ins check box is clear. 

 

Microsoft Edge Configurations 
If you are using Microsoft Edge, do the following to restore default configurations: 

 In Microsoft Edge, click Ctrl + Shift + Delete. 

A Clear browsing data pane appears. 
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 Ensure all of the check boxes are selected. 

 Click Clear now. 

 Close and relaunch the browser. 

The application should now be reset and the defaults restored. 

 

 

 



 

 
© Finastra  |  Fusion NetCapture  |  Web Client User Guide 92 

A Internet Explorer Security Settings 
Web Client relies on Microsoft Internet Explorer to provide a balance of security and usability. Internet 
Explorer includes options for setting up browser security to protect your computer against Internet threats 
such as programs that would try to gain access to your computer or data. While having a highly secured 
browser is important, too much security can make using a web-based application such as Web Client difficult: 
key components might be blocked completely or made difficult to use because of warning messages. 

The goal of this section is to suggest ways in which you can find the balance between ensuring security and 
enabling Web Client to let you quickly and efficiently process deposits. You do not need to set up your 
browser according to the suggestions provided below to run Web Client, nor does Finastra guarantee that by 
following these suggestions that your computer will be completely protected from Internet attacks. 

 Best Practices 
 Internet Explorer Zones 
 Advanced Settings 
 Cookies 
 Pop-up Blocker 
 AutoComplete 

Best Practices 
The purpose of this section is to briefly outline the suggested security settings for Internet Explorer. 

The following sections explain more about making the settings. 

Option Suggested 
Settings Issue 

Security Tab (Zones). See Internet Explorer Zones. 

Internet Zone High To ensure maximum security from Internet threats, the 
slider should be set to High. See Internet Zone. 

Intranet Zone Medium If you are accessing Web Client through the Intranet, a 
setting not higher than Medium security let all of the 
applications run without hindrance. See Local Intranet 
Zone. 

Trusted Sites Zone Medium Add the Web Client URL as a trusted site on your 
computer. You can then set the slider to no higher than 
Medium to run Web Client without hindrance. See Trusted 
Sites Zone. 

Security Tab (Custom Level Settings). See Custom Level Settings. 

Automatic prompting for 
ActiveX controls 

Enable or 
prompt in all 
zones 

The Web Client requires this setting to run correctly. 

Binary and script 
behaviors 

Enable in all 
zones 

The Web Client requires this setting to run correctly. 

Download signed ActiveX 
controls 

Enable or 
prompt in all 
zones 

The Web Client requires this setting to run correctly. 
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Option Suggested 
Settings Issue 

Run ActiveX controls and 
plugins 

Enable or 
prompt in all 
zones 

The Web Client requires this setting to run correctly. 

Active Scripting Enable in all 
zones 

The Web Client requires this setting to run correctly. 

Advanced Tab. See Advanced Settings. 

Use SSL 3.0 Enable in 
Advanced 
Settings 

Secure Socket Layer 3.0 lets you connect securely with 
Web Client. 

Do not save encrypted 
pages to disk 

Disable in 
Advanced 
Settings 

Web Client requires this setting to run correctly. 

Privacy Tab.  

Privacy High If you are using the Intranet or Trusted Sites zones, you 
can set Privacy to High to block cookies from the Internet 
Zone. If you must use the Internet zone to access Web 
Client, set Privacy no higher than Medium. See Cookies. 

Pop-up Blocker Disable for the 
Web Client site 

Add the Web Client site to the Allowed Sites list. See Pop-
up Blocker. 

Content Tab.  

AutoComplete Disable Disable AutoComplete to ensure login names and 
passwords cannot be circumvented. 

Internet Explorer Zones 
Internet security settings are accessible through the Internet Options dialog box. You can access the Internet 
Options dialog box in two ways: 

 Start > Control Panel > Security Center > Internet Options 
 In Internet Explorer, choose Tools > Internet Options 
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Define the security settings for different zones in the Security tab of the Internet Option dialog box. 

 

Zones are Internet Explorer’s way of specifying different security settings according to where you browse. 
There are four zones: Internet, Local Intranet, Trusted Sites, and Restricted Sites. You can assign a different 
level of security to each zone. For example, you can set up security to be tighter for general Internet sites 
while intranet and specific, trusted sites can safely have looser security settings. 

 Internet Zone 
 Local Intranet Zone 
 Trusted Sites Zone 
 Custom Level Settings 

Internet Zone 
Because the general Internet is external to your company’s network, it is possible to access unsafe sites. It is 
important to be careful where you browse and what type of information and automation you accept. Many 
companies set policies that determine the security level for Internet browsers. The Internet zone allows a 
company to specify the security for general Internet usage. They may have requirements for this zone to be 
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very high security to prevent intrusion. However, the high settings could block Web Client from running or 
make it difficult and time-consuming to use. 

Local Intranet Zone 
The local intranet zone is internal to your organization. Because your intranet is not exposed to the general 
Internet, it is already secured from threats. If Web Client is running within your intranet, you can safely reduce 
the security settings for the Local Intranet zone. 

Trusted Sites Zone 
The Trusted Sites zone lets you list the sites that you know do not pose a security threat. If you are not 
running Web Client from an intranet site, you can list the IP address as a trusted site so you can reduce the 
security settings for the Trusted Sites zone. 

Trusted Sites Settings 

To add an address to the trusted sites list, do the following: 

 From the Security tab, click Trusted Sites and click the Sites button. 

The Trusted Sites dialog box appears. 

 
 In the Add this web site to the zone text box, type the address you were given for Web Client. Make 

sure you include https:// as part of the address. 

 Click Add. 

Note: If the Server Reporting application is on a different server, you will need to include the address 
for that server as well. 

 When you have finished, click OK to close the Trusted Sites dialog box. 

 Move the security level slider to no higher than Medium. 

Custom Level Settings 
Each zone can be customized by clicking Custom Level and selecting from the listed settings. Customizing 
the settings lets you set the appropriate level of security for the associated zone. The Best Practices settings 
should be applied to the zone through which you will be accessing Web Client. 
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Advanced Settings 
Advanced Settings lets you enable or disable specific settings for Internet Explorer. Most of the settings can 
be left in their default settings. However, you should set Use SSL 3.0 and “Do not save encrypted pages to 
disk” to the settings suggested in the Best Practices table. 

To set the Advanced Settings, do the following: 

 From the Internet Options dialog box, click the Advanced tab. 

 Scroll down to find and modify the setting. 

 Click Apply. 

Cookies 
Web Client uses cookies to track logins and for other vital information. If cookies are disabled, Web Client will 
not be able to function. Cookies settings are handled in the Privacy tab, and therefore are not part of the 
Security settings discussed above and need to be set separately. 

 Privacy Settings 

Privacy Settings 
The Privacy tab includes a slider that sets the privacy level for all sites in the Internet zone. The Intranet and 
Trusted Sites zones automatically accept all cookies. 

If you will be using the Internet zone for accessing Web Client, you should consult your system administrator 
for the Privacy settings. You can also find more information about Privacy settings and Cookies by searching 
for cookies at support.microsoft.com. 

Pop-up Blocker 
Internet Explorer can include a pop-up blocker for preventing browser windows from opening automatically. 
The purpose of the function is to prevent unwanted ads from opening when you open a Web site. Web Client 
uses pop-ups as alerts and dialog boxes to make your experience with the application easier to interact with. 
If the pop-up blocker is enabled, Web Client will not function properly. 
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 Disabling Pop-up Blocking 

Disabling Pop-up Blocking 
If your company requires that the pop-up blocker be enabled, you will need to exclude the Web Client site. To 
exclude the Web Manager Web Client site, do the following: 

 From the Privacy tab, click Trusted Sites, then click the Sites button. 

The Per Site Privacy Action dialog box opens. 

 
 In the Address of Web site text box, type the address you were given for Web Client. Make sure you 

include https:// as part of the address. 

 Click Allow. 

When you have finished, click OK to close the Per Site Privacy Actions dialog box. Internet Explorer will now 
accept all cookies from Web Client. 

AutoComplete 
AutoComplete records the user name and passwords you use to log in to secured sites. Enabling 
AutoComplete gives others who use your computer access to sites that require a user name and password. 
For security reasons, you should disable AutoComplete. 

 Disabling AutoComplete 

Disabling AutoComplete 

To disable AutoComplete, do the following: 

 From within the Internet Options dialog box, click the Content tab. 
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 In the AutoComplete section, click Settings. The AutoComplete settings dialog box opens. 

 
 Click User names and passwords on forms to remove the check from the box. 

 Click OK. 
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Finastra Support 

Finastra support offers several options to help you get the most out of your software, including a self-service 
Case Management tool, and phone support. 

Please visit the Finastra Customer Center at https://customercenter.dh.com/ to log in to our online self-service 
Case Management system. If you forgot your password, simply click the Forgot Password link. Once logged in to 
Customer Center, you have the ability to use the Knowledge Center to troubleshoot issues and answer 
questions. 

If your financial institution is not currently using these tools and would like to, please contact Finastra support for 
assistance. 

Note:  The Financial Modernization Act of 1999, also known as the Gramm-Leach-Bliley Act or GLB Act, 
includes provisions to protect consumers' personal financial information held by financial institutions. Therefore, 
Finastra support cannot accept data or screen captures that contain personal financial information via email or 
fax. For information about secure file transfer methods, contact Finastra support. 

https://customercenter.dh.com/
https://customercenter.dh.com/Auth/ForgotPassword
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About Finastra 
Finastra unlocks the potential of people and businesses in finance, creating a platform for open 
innovation. Formed in 2017 by the combination of Misys and D+H, we provide the broadest 
portfolio of financial services software in the world today—spanning retail banking, transaction 
banking, lending, and treasury and capital markets. Our solutions enable customers to deploy 
mission critical technology on premises or in the cloud. Our scale and geographical reach 
means that we can serve customers effectively, regardless of their size or geographic 
location—from global financial institutions, to community banks and credit unions. Through our 
open, secure and reliable solutions, customers are empowered to accelerate growth, optimize 
cost, mitigate risk and continually evolve to meet the changing needs of their customers. 48 of 
the world’s top 50 banks use Finastra technology. Please visit finastra.com. 

North American Headquarters 
744 Primera Boulevard 

Suite 2000 
Lake Mary, FL 32746 

United States 
T: 1-800-989-9009 

 

http://www.finastra.com/
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